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The tools How ArcToolbox helps you work
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IN THIS CHAPTER

7

Quick-start tutorial 2
• Exercise 1: Organizing your data

in ArcCatalog

• Exercise 2: Processing the forest
stands

• Exercise 3: Processing the
streams and roads

• Exercise 4: Converting data

• Exercise 5: Creating the analysis
coverage

• Exercise 6: Computing the timber
value

Conducting a GIS processing project is easier than ever with the powerful
tools in ArcToolbox. When used in conjunction with ArcCatalog�the applica-
tion for browsing, storing, organizing, and distributing data�ArcToolbox lets
you meet the geoprocessing needs of your project quickly and efficiently.

In this tutorial, you�ll use ArcToolbox and
ArcCatalog to conduct a logging study for a
portion of the Tongass National Forest in south-
eastern Alaska. By performing overlays, buffers,
and other geoprocessing tasks with ArcToolbox,
you�ll calculate the dollar value of trees in areas
suitable for logging. You�ll use ArcCatalog to
organize and manage your data, as well as to
immediately preview the results for each step.

The study area is shown here. You will conduct
the study for the PetersburgB4 and PetersburgB5
15-minute quadrangles. You will use base cover-
ages and grids for forest stands, rivers, roads, and

old growth to complete the study. This data has been provided with the
software. Additionally, several of the coverages you would normally derive in
the course of this project are provided to eliminate repetitive processing steps.

When conducting your analysis, you must keep certain study criteria in mind.
First, harvest areas must be 100 meters from all roads and fish spawning
streams. Second, areas must not include old growth forest.

03Ch02.p65 12/18/2000, 10:30 AM7



8 USING ARCTOOLBOX

You�ll use several datasets throughout the course of the
project. The following table provides descriptions of these
datasets.

Coverage Description

Oldgrowgrid Grid of old growth forest stands

Overlay3 Overlay of buffered roads and streams,
forest stands, and old growth forest

Road Major roads

Roadbuf Major roads buffered 100 meters

Standb5 Forest stands for PetersburgB5 in Univer-
sal Transverse Mercator (UTM)

Standddb4 Forest stands for PetersburgB4 in decimal
degrees

Stream Streams

The data you�ll need for this tutorial is included on the
ArcToolbox installation disk. The datasets were provided
courtesy of the USDA Forest Service, Tongass National
Forest, Ketchikan Area. They have been simplified by
ESRI. The Forest Service cannot assure the reliability or
suitability of this information. Original data was compiled
from various sources, and spatial information may not meet
National Map Accuracy Standards. This information may
be updated, corrected, or otherwise modified without notice.

All exercises in the tutorial are processed locally, rather
than being sent to a Geoprocessing Server for remote
processing. It is recommended that you do not use the
Geoprocessing Server for this tutorial if you have ArcInfo
Workstation installed locally. If you need to use a

Geoprocessing Server, see �Using a Geoprocessing Server�
in Chapter 3 before you start the tutorial.

This tutorial is designed to let you explore the capabilities of
ArcToolbox and ArcCatalog at your own pace and without
the need for additional assistance. You�ll need about one
hour of focused time to complete the six exercises in the
tutorial. However, you can also perform the exercises one
at a time if you wish.

03Ch02.p65 11/29/2000, 3:29 PM8



QUICK-START TUTORIAL 9

Exercise 1: Organizing your data in ArcCatalog

Before you begin your geoprocessing and analysis work,
you must first find and organize the data that you�ll need.
You should organize your data in such a way that you�ll be
able to find it quickly and efficiently. This will be done
using ArcCatalog.

Copying and connecting to data

You�ll begin by copying the tutorial data provided with the
ArcToolbox software to a folder on a local disk. You will
work with a copy of the data locally if the data was in-
stalled on a connected disk, in order to maintain the
integrity of the original data. Once it has been copied, you
will then create a connection to the folder containing the
data in ArcCatalog.

1. Start ArcCatalog by either double-clicking a shortcut
installed on your desktop or using the Programs list in
your Start menu.

2. Copy the ArcToolbox tutorial data from the directory
where it is installed to your own tutorial workspace. In
the examples shown here, the data has been copied to
local drive D:\ and placed in a folder called �tutorial�.

In ArcCatalog, data is accessed through folder connec-
tions. When you look in a folder connection, you can
quickly see the folders and data sources it contains.
You�ll now begin organizing your tutorial data by
creating a folder connection to it.

3. Click the Connect To Folder button and navigate to the
data folder. Click OK to establish a folder connection.

Your new folder connection�D:\tutorial\Tongass�is
now listed in the ArcCatalog tree. You will now be able
to access all of the data needed for your project through
that connection.

Exploring your data

Before you begin your analysis, you should explore the
datasets provided for the project. This will help you get a
better feel for ArcCatalog and the tutorial data.

1. Click the Thumbnails button on the Standard toolbar to
display previously created thumbnail images of the
datasets in your Tongass folder.

Layers have been created for all the coverages. The
Standb5 coverage is in a UTM projection, while
Standddb4 is in unprojected decimal degrees. All other
coverages and grids have been merged and are in UTM
projection.

3
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10 USING ARCTOOLBOX

4. Right-click the VALUE-PER-METER field to open a
context menu. Sort the table into ascending and then
descending order. What is the lowest nonzero value per
meter? What is the greatest?

Starting ArcToolbox

In the remaining sections of the tutorial, you�ll conduct your
geoprocessing work using ArcToolbox. You�ll still need to
use ArcCatalog to manage and examine your datasets.
Keep both applications open for the remainder of the
tutorial.

1. Click the Launch ArcToolbox button on the ArcCatalog
toolbar to start ArcToolbox.

2. Click the plus sign next to the D:\tutorial\Tongass
connection to see the datasets contained in the folder.
Click the Preview tab and click each dataset in the tree.

3. Double-click the Standb5 coverage to open it. Click the
polygon feature class. Click the Preview dropdown
arrow and click Table to see the feature attribute table
contents. The VALUE-PER-METER field stores the
value of the timber in each forest stand as a density�
dollars per meter squared.

Polygons with a value-per-meter attribute of zero are
nonforested areas such as lakes and grasslands. Be-
cause the purpose of this project is to calculate the value
of trees in areas suitable for logging, you will exclude the
nonforested areas from the timber harvest. You will then
compute the value of the timber in the remaining area
using this attribute.

2

3

1

4

1
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You can also start ArcToolbox as you would any other
application�from the Start menu or from a shortcut on
your desktop.

2. Both the ArcCatalog and ArcToolbox windows should
now be open. Size and arrange the two applications on
your screen so that both are visible.

You are now ready to start the first part of the tutorial:
processing the forest stands. You�ll be introduced to several
ArcToolbox tools and wizards and will use these for your
analysis.
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Exercise 2: Processing the forest stands

In the first exercise, you prepared for the latter exercises
by organizing your data. Now you are ready to begin
processing your data. Two forest stand coverages�
Standddb4 and Standb5�currently cover the entire study
area. Before you can begin your study, these coverages
must be merged.

As noted in Exercise 1, the Standb5 coverage is projected
in a UTM coordinate system, while the Standddb4 coverage
is in unprojected decimal degrees. In order for you to
conduct a meaningful analysis of these areas, the coverages
must share the same coordinate system. For this reason,
you will project Standddb4 to match the coordinate system
of Standb5. Once this is done, the topology will have to be
rebuilt as it is lost when a coverage is projected.

Projecting a coverage

ArcToolbox software�s Project Wizard lets you easily
project a coverage to another coordinate system. You can
use the Project Wizard to manually define the output
projection (you supply all the projection parameters), or you
can have the wizard use the projection information stored in
an existing coverage. For this study, you�ll use the wizard to
project the Standddb4 coverage to match the coordinate
system of Standb5.

1. Double-click the Project Wizard (coverages, grids) in the
Projections toolset of Data Management Tools.

The first panel of the Project Wizard (coverages, grids)
should now be open. You will use the projection informa-
tion in Standb5 to project Standddb4.

2. Click the option to Project my data to match existing
data. Click Next.

This panel is used to specify your input coverage.
ArcToolbox gives you several options for setting input
and output dataset names. You can type the full
pathname to the dataset into the text box. You can also
click and drag a dataset, or datasets, from the
ArcCatalog tree or Contents tab and drop it on the text
box. Alternatively, you can click the Browse button to
open the ArcCatalog browser and navigate to your
dataset.

ArcToolbox has a feature called sticky paths. This
means that it remembers the path to the last dataset you
specified and will assume that the same path applies
when you type only a dataset name into another tool or
wizard. It also remembers output dataset paths.

1
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Tutorial instructions will simply ask you to type coverage
names and their paths into the appropriate text boxes.
However, feel free to use any of the techniques just
described to make the entry.

3. Type �D:\tutorial\Tongass\Standddb4� in the Dataset text
box. Click Next.

Use the next panel of the wizard to specify the name of
the coverage whose projection information will be used
to define the output projection. You will use Standb5 to
define it. Notice that in both this and the previous panel,
the wizard displays the projection information for the
coverage you have selected.

4. Type �D:\tutorial\Tongass\Standb5� in the Dataset text
box. Click Next.

The next panel appears, where you will specify the
output coverage name. You will call the output coverage
�Standb4� and store it in your Tongass folder.

5. Type �D:\tutorial\Tongass\Standb4� for the output
dataset. Click Next. A summary page appears. Once you
have reviewed the summary, click Finish.

A message appears to tell you that the wizard is pro-
cessing your request. This message appears in all tools
and wizards when a process is active. When the tool or
wizard is finished, the message disappears, indicating
that the process is complete.

Your new coverage should now appear in your Tongass
folder.

6. Click the Standb4 coverage in the Catalog tree and click
the Preview tab. Switch to Geography on the Preview
dropdown list to see your new coverage.
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14 USING ARCTOOLBOX

Building topology

If you double-click the Standb4 coverage in the ArcCatalog
tree, you�ll note that the coverage doesn�t contain a poly-
gon feature class. This is because changing a coverage�s
projection removes its topology. You must now rebuild
polygon topology for your new coverage using the Build
tool before going any further with your analysis.

1. Double-click the Build tool in the Topology toolset of
Data Management Tools.

2. Type �D:\tutorial\Tongass\standb4� in the Input coverage
text box.

3. Change the Feature class to Poly. Click Yes on the
subsequent message box to confirm Poly as the desired
feature class. Click OK.

The Standb4 and Standb5 coverages are now in the
same projection (UTM), and your new coverage has
polygon topology. The next step is to merge the cover-
ages together so that the data can be used as one
dataset that matches the extents of the other coverages
in the study.

Merging datasets

You can use the Append Wizard to merge the two cover-
ages.

1. Double-click Append Wizard in the Aggregate toolset of
Data Management Tools.

The Append Wizard joins multiple coverages together
when you type their names in the Coverages to be
appended text box. The easiest way to do this is to use
the browser and select all of the datasets at once.
Simply click the coverage, then hold down the Ctrl or
Shift key while clicking the other coverages to select
them all.

1
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2. Click the Browse button and navigate to the
D:\tutorial\Tongass folder. Select Standb4 and Standb5
and click the Open button.

Your coverages should now be listed on the wizard. If
you made a mistake, you can remove a coverage by
selecting it and clicking the Delete button next to the
list.

3. Click Next.

The next panel of the wizard appears. You will use it to
specify the feature classes that will be merged.

4. Click Poly in the Feature classes list.

5. Click Next.

This panel is used to specify the name of an optional clip
coverage. You will not use a clip coverage in this tuto-
rial.

6. Click Next.

Use the next panel to specify the output coverage name
and to offset the feature IDs. Unique feature IDs
within the output coverage are necessary in order to
maintain a relationship between the new features and
the originals.

7. Type �D:\tutorial\Tongass\stand� in the Output coverage
text box. Click the Create unique IDs dropdown arrow
and click Features only. Click Next.

8. Review the summary panel and click Finish.

Your forest stand data is now ready to be used with the
other Tongass datasets in the next exercise. By analyzing
the forest stand data along with the coverages you�ll create
in the upcoming tasks, you will determine which areas are
suitable for harvest and how valuable those areas are.

2
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16 USING ARCTOOLBOX

In the last exercise, you processed the forest stands; now
you will process the streams and roads data to eliminate the
areas that do not meet the first of the specified criteria:
harvest areas must be at least 100 meters from all fish
spawning streams and roads.

To process the streams, you will first select and extract
stream segments flagged as fish spawning grounds and
place them in a new coverage named Fish. You will then
generate a 100-meter buffer around each segment.

To meet the second part of the criterium�harvest areas
must be at least 100 meters from roads�you would have to
create a similar buffer. However, this step has already been
completed for you to avoid repetition; the extracted roads
are represented by the Roadbuf coverage.

Extracting features

Using the Select tool, you will extract streams that are
flagged as fish spawning areas to a new coverage. But
first, you should examine the stream coverage in
ArcCatalog to see how many streams are in the study area.

1. Click the Stream coverage in the ArcCatalog tree and
click the Preview tab to examine the coverage.

2. Double-click the Select tool in the Extract toolset of
Analysis Tools.

You will now specify the coverage and feature class that
you are processing, the logical expression that identifies
the features (there is a button that opens a query
builder), and the output coverage and feature class.

3. Type �D:\tutorial\Tongass\stream� in the Input coverage
text box.

4. Click the Input feature class dropdown arrow and click
Line.

Exercise 3: Processing the streams and roads

2

6

Q
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5
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5. Click the first option to Build a query if it is not already
selected.

6. Click the Query Builder button to open the Query
Builder dialog box.

You�ll use the Query Builder to create the logical
expression that identifies the features you want to select.
You can type the expression directly into the text box or
build the expression by clicking the fields, operators,
connectors, and values. You must choose the selection
method before creating the expression, as it affects the
expression�s logic. Once a suitable expression is cre-
ated, you can add it to the tool�s expression list.

The default selection method is subset. If you are
familiar with the ArcInfo TABLES� module, subset is
the same as using the RESELECT keyword when you
create a selection expression.

7. Type the expression �AHMU-CLASS = 2� in the
Current expression text box. Keep the default selection
method.

The item AHMU-CLASS is used to classify the stream
types. All spawning streams have a value of 2. The
expression tells the Select tool to extract only those
streams with a value of 2�that is, the fish spawning
streams.

8. Click the down arrow button next to the Current expres-
sion text box to add the expression to the list.

9. Click OK to close the Query Builder.

Call your new coverage Fish and save it in your Tongass
folder.

10. Type �D:\tutorial\Tongass\Fish� in the Output coverage
text box on the Select tool. Click OK.

A message appears when the processing is complete
asking whether you want to see the output tool mes-
sages. Click Yes and review the number of input and
output lines.

You can now view your new Fish coverage in
ArcCatalog.

8

7
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Creating a buffer

Now that you�ve created a coverage representing the fish
spawning streams, you can build a 100-meter buffer around
them using the Buffer Wizard. You�ll end up with a new
coverage called Fishbuf.

1. Double-click Buffer Wizard in the Proximity toolset of
Analysis Tools.

2. Click Next after reading the introductory panel. You
want the output coverage to contain polygons, not

regions, so accept the default buffer type and click
Next.

3. Type �D:\tutorial\Tongass\Fish� as the coverage you
want to buffer. Click Next.

4. Accept the Single buffer with Specified distance option
and click Next.

5. Type �100� as the buffer distance in meters and click
Next.

6. Click Both sides with round ends for the buffer style.
Click Next.

7. Type �D:\tutorial\Tongass\Fishbuf� as the output cover-
age.

You must now set the inside and outside values for the
output coverage. Inside and outside values are used to
determine which areas are inside or outside the buffer
area.

7
1

03Ch02.p65 11/29/2000, 3:33 PM18



QUICK-START TUTORIAL 19

8. Type �IN-FISH� as the item name. Type �1� for the
inside value and �0� for the outside value. Click Next
when finished.

9. After reviewing your choices on the last panel, click
Finish to run the wizard.

10. View your Fishbuf coverage in ArcCatalog.

11. Examine the polygon attribute table for Fishbuf. Note
the IN-FISH field and its values. Records with an IN-
FISH value of 0 indicate a polygon that is not within
100 meters of a stream, while records with a value of 1
are within that distance. This item and its values will be
important in a latter step that determines what areas are
available for forest harvesting.

As mentioned earlier, one of the timber value criteria
requires a 100-meter buffer on major roads. To make
this buffer, you would follow the same process you just
followed to create the Fishbuf coverage.

However, to eliminate a repetitive step, the Roadbuf
coverage was created for you. It is in your Tongass
directory; use ArcCatalog to examine it. Pay particular
attention to the IN-ROAD polygon attribute.

In the next exercise, you�ll create an old growth forest
coverage. This coverage, along with the Stand, Fishbuf, and
Roadbuf coverages, will be used to generate the final
results.
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20 USING ARCTOOLBOX

In the previous exercises, you processed forest stands,
streams, and roads to help in your study. Now, you�ll
convert the grid of old growth forest areas into a coverage
that will be used in an overlay with the forest stands. This
grid was created exclusively for this tutorial; it was not
provided by the Forest Service.

You�ll use the Grid to Polygon Coverage tool to complete
the conversion.

1. Double-click Grid to Polygon Coverage in the Export
from Raster toolset in Conversion Tools.

2. Type �D:\tutorial\Tongass\oldgrowgrid� in the Input grid
text box. Type �D:\tutorial\Tongass\Oldgrow� in the
Output coverage text box. Click OK.

Exercise 4: Converting data

When the tool is finished processing the request, you
should see your new coverage, Oldgrow, in the
ArcCatalog tree.

3. Click the Preview tab in ArcCatalog to view the
Oldgrow coverage in Preview view. Zooming in reveals
the common stair-step effect found in vector data that
has been converted from raster data.

4. Examine the attributes for the coverage�s polygon
feature class. Areas of old growth have a GRID-CODE
value of 1. All other areas were �Nodata� in the grid
and have a value of -9999. When inadequate information
is available for a cell location of a grid, the location can

1
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be assigned a value of Nodata. Nodata and �0� are not
the same; �0� is a valid value. Because Nodata repre-
sents inadequate information, Nodata cells cannot be
used in calculating the statistics in a grid�s statistics
(STA) table.

You now have all the coverages you need for your
analysis. In the next exercise, you�ll overlay them to
create a final coverage for the study.
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Now that you have organized, processed, and converted
your data, you are ready to create the final analysis cover-
age. To create the final analysis coverage, it is necessary to
overlay the Stand, Fishbuf, Roadbuf, and Oldgrow cover-
ages. This would normally require you to perform two union
overlays�Roadbuf with Fishbuf, and Stand with
Oldgrow�and then intersect the two resulting coverages to
create the final analysis coverage.

However, to avoid repetitive tasks, you will only perform
one union overlay�Roadbuf with Fishbuf�so that you
can experience the Overlay wizard. The final coverage
required for the analysis has been created for you and is
named Overlay3. You will examine the Overlay3 coverage
at the end of this section.

1. Double-click Overlay Wizard in the Overlay toolset in
Analysis Tools.

Exercise 5: Creating the analysis coverage

2. Click the third option to Combine the polygons from
two coverages, then click Next.

3. Type �D:\tutorial\Tongass\Fishbuf� as the input
coverage. Click Next.

4. Type �D:\tutorial\Tongass\Roadbuf� as the overlay
coverage. Click Next.

2
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5. Click the option to Keep all attributes from both cover-
ages, as they are needed to determine what areas are
outside of the road and stream buffers. Click Next.

6. Type �D:\tutorial\Tongass\Overlay1� as the name of the
output coverage. You want to use the default fuzzy
tolerance, so click Next.

7. Review the summary panel to ensure all input is correct.
Click Finish when you are done.

As mentioned, the final overlay coverage, Overlay3, was
created for you. Overlay3 was created using the same
procedure you just followed. All of the extra fields
resulting from the series of overlays (Cover#, Cover-ID)
were deleted using ArcCatalog as they are not required
for this analysis. The items created in the buffered
coverages and the converted grid will be used to deter-
mine what areas are harvestable.

5

8. View the Overlay3 coverage in the Catalog. Examine
the attribute values of the polygon attribute table. You
should see the items you created when you buffered the
roads and streams as well as the item created in the grid
conversion.

You should now have a clear understanding of the steps
that were needed to arrive at this point. ArcToolbox broke
down complex tasks into easy-to-follow tools and wizards,
and ArcCatalog allowed you to immediately preview your
results.

With all of the geoprocessing work complete, you are ready
for Exercise 6: Computing the timber value.
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The first five exercises focused on geoprocessing tasks. In
this exercise, you will build on these tasks by computing the
value of the trees in harvestable areas. These are areas
that are not old growth and are 100 meters away from fish
spawning streams and major roads. You will use the Select
tool to extract the polygons that meet these criteria into a
new coverage called Cutareas. The Statistics tool will then
weight the VALUE-PER-METER field by the area of each
polygon and sum the results.

Remember that value-per-meter is a density expressing the
value of the original stands in terms of dollars per square
meter. Because this value is a density, it still applies even
though the original stand polygons have been divided into
many smaller polygons through the sequence of overlays
that you have performed.

Extracting the polygons

You will begin by extracting the polygons that meet all of
the criteria.

1. Double-click the Select tool in the Extract toolset of
Analysis Tools.

2. Type �D:\tutorial\Tongass\Overlay3� in the Input cover-
age text box.

3. Click the Input feature class dropdown arrow and click
Poly.

Exercise 6: Computing the timber value

4. Click the Query Builder button to open the Query
Builder dialog box. Create a logical expression to select
all polygons that have a value not equal to 1 for the IN-
ROAD, IN-FISH, and GRID-CODE items. The item
that stores the old growth flag was given the name
GRID-CODE. Remember that you can type the expres-
sion directly into the text box or build it by clicking the
fields, operators, connectors, and values. Keep the
default selection method of subset.

5. Type �D:\tutorial\Tongass\Cutareas� in the Output
coverage text box. Click OK.

5 4
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6. Examine the Cutareas coverage in ArcCatalog.

Visually, your new coverage is not much different from
your Overlay3 coverage. However, in the new coverage,
polygons that can�t be harvested now have all their at-
tributes set to 0. This includes the VALUE-PER-METER
field. You can easily verify this by opening the Cutareas
polygon attribute table and sorting it on cutareas-id. Those
polygons with an ID of 0�there are quite a few�didn�t
meet your criteria.

Generating statistics to show timber value

The last part of this tutorial involves using the Statistics
Wizard to compute the dollar value of the trees in each
polygon and to get a sum of all the values. The wizard will
do this by multiplying the polygon areas (which are in
square meters) by the VALUE-PER-METER values
(which are in dollars per square meter). The result will be
written to one record in an INFO� file.

1. Double-click Statistics Wizard in the Statistics toolset of
Analysis Tools.

2. Click the second option to sum the contents of the value-
per-meter item. Click Next.

3. Type �D:\tutorial\Tongass\cutareas.pat� as the input
table. Click Next.

2
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4. Click the Statistical method dropdown arrow and click
Sum.

5. Click VALUE-PER-METER in the Item list.

6. Check Weight item and click AREA in the list.

7. Click the down arrow button to add the expression to the
list. Click Next.

8. Click Calculate statistics for all records. Click Next.

9. Type �D:\tutorial\Tongass\timbervalue� as the output
table name. Click Next. Click Finish after reviewing the
summary.

10. Examine your new timbervalue table in ArcCatalog
using Preview view. What is the total value of all
harvestable timber in the study area? If your number is
about $2.7 billion, then you didn�t make a mistake. Trees
are worth a lot of money! Of course, this is the value of
almost 110 square miles of forest.

This tutorial introduced you to the extensive capabilities of
ArcToolbox and ArcCatalog. Using both applications, you
quickly and easily performed a number of GIS operations
and observed the results. You can now use these applica-
tions to perform your own analyses.

You have yet to uncover many features of ArcToolbox. In
the next few chapters, you will review all the features that
make ArcToolbox a user-friendly and complete GIS
application for your daily needs.

4 5 6
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IN THIS CHAPTER

 3
• Starting ArcToolbox

• What are toolsets?

• Starting a tool

• Finding the tools you need

• Getting help

• Setting the precision environment

• Using and defining relates

• Using ArcCatalog

• Dragging and dropping data

• Operating tools in batch mode

• Batch processing in wizards

• Using a Geoprocessing Server

• Checking a remote process

• Scheduling a remote process

ArcToolbox basics

ArcToolbox lets you work with data from different sources, run a tool or
wizard on multiple datasets, and direct where the processing will occur. Tools
and wizards are arranged in a logical manner to help you find them quickly
and start the task at hand.

You�ll find that using ArcToolbox with ArcCatalog increases your productivity
when performing geoprocessing or conversion tasks. It doesn�t take long to
become familiar with the ArcToolbox interface, as the tools are organized into
toolsets that have names that are representative of functions.
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Starting
ArcToolbox
Starting ArcToolbox is the first
step to geoprocessing. How-
ever, before you can start,
ArcToolbox must be installed
on your computer or network. If
you don�t know whether it�s
installed yet, check with your
system administrator or install it
yourself using the installation
guide.

Once the software is installed,
you can start ArcToolbox from
the Start button on the Win-
dows taskbar.

Starting ArcToolbox from
the Start menu

1. Click the Start button on the
Windows taskbar.

2. Point to Programs.

3. Point to ArcGIS.

4. Click ArcToolbox.

Tip

Starting ArcToolbox from
ArcCatalog
You can also start ArcToolbox from
ArcCatalog by clicking the
Launch ArcToolbox button on the
Standard toolbar.

4

1
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The tools in ArcToolbox are organized into four main toolsets.
They are:

� Data Management Tools

� Analysis Tools

� Conversion Tools

� My Tools

The ArcToolbox tree begins with the four main toolsets. When
you click an item in ArcToolbox, a description appears at the
bottom of the menu.

You can change the size of the ArcToolbox window and position
it anywhere you like on your desktop. Changes you make to its
size and position remain in future sessions.

Each main toolset is comprised of a number of smaller toolsets.
These toolsets further organize the tools into groups based on
their function. The name of each toolset describes the type of
tools it contains.

The Data Management Tools toolset contains a number of
smaller toolsets that further organize its contents. With Data
Management Tools, you can manage a coverage�s topology, map
projection, and attributes. If you need to modify the characteris-
tics of a coverage or table, you can use this toolset.

In the Analysis Tools toolset, you find most of the geoprocessing
power of ArcToolbox. With the tools in this toolset, you can
perform overlays, create buffers, calculate statistics, merge
datasets, and much more. When you want to solve a spatial or
statistical problem, you should always look in the Analysis Tools
toolset.

What are toolsets?
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See Also

Within the Conversion Tools toolset are the tools you need to
convert coverages, grids, and TINs to other supported data
formats. The tools are organized into smaller toolsets that pertain
to the type of conversion being performed. Most commonly used
data formats are supported.

ArcToolbox provides wizards to assist you in the more complex
conversions. Use Conversion Tools whenever you need to
change one type of dataset to another.

The last of the main toolsets is My Tools. You can modify this
toolset by adding the tools you use most frequently or tools
associated with a common task. When you first start ArcToolbox,
only two tools are presented. One of these is a wizard that guides
you through the process of installing a custom tool; the other
tool runs an AML script. My Tools does not initially have
toolsets. You can customize it by creating your own toolsets.
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Starting a tool
Before using a tool for
geoprocessing, you must start
it from ArcToolbox. You can
start a tool in several ways:

� From the ArcToolbox tree

� From the tool�s context
menu

� From the Tools menu

The Tools menu displays the
last four tools you have used.
This lets you start a recently
used tool quickly when you
need it again.

Starting a tool from the
tree

1. Navigate to the tool you want
to start.

2. Double-click the tool.

The dialog box for the tool
appears.

Starting a tool from its
context menu

1. Navigate to the tool you want
to start.

2. Right-click the tool and click
Open.

The dialog box for the tool
appears.

Starting a tool from the
Tools menu

1. Click Tools.

2. Click the tool you want to
start.

The dialog box for the tool
appears.

2

2

2

Tip

Another way to start a tool
from the Tools menu
You can also start a tool by
selecting it and clicking the Tools
menu, then clicking Open.
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Finding the tools
you need
You can use the ArcToolbox
Main menu to help you find the
tool you want to use.
ArcToolbox provides a Find
tool that offers three ways to
locate a tool.

You can find the location of a
tool by using its name, the
equivalent ArcInfo command, or
a keyword.

Use an ArcInfo command when
you know the command name
but not the tool name.

A keyword best describing the
task you want to perform is
useful when you don�t know a
tool�s name or the equivalent
ArcInfo command.

Finding a tool by its name

1. Click Tools and click Find.

2. Type the name of the tool you
want to find in the text box.

3. Click Find Now.

A list of all tools containing
the name you typed appears.

4. Double-click a tool to start it.

The dialog box for the tool
appears.

1

Tip

Are they all here?
ArcToolbox is a collection of
ArcInfo software�s most used
geoprocessing and conversion
commands. It is possible that the
tool you are looking for does not
exist in ArcToolbox yet. If you are
unable to find the tool you need,
you can still run the command in
ArcInfo.

2

3

List of tools containing
the name you typed in
the text box

04Ch03.p65 11/29/2000, 3:38 PM32



ARCTOOLBOX BASICS 33

Tip

Using the Tab key
You can use the Tab key to move
the focus on a tool from one
ArcToolbox element to another.
When a text box has focus, it has an
active cursor. A button with focus
has a highlighted outline. The
element with focus is the one you
are currently using.

Finding a tool using the
equivalent ArcInfo
command

1. Click the Tools menu and
click Find.

2. Click the ArcInfo command
tab.

3. Type an ArcInfo command in
the Command name text box.

4. Click Find Now.

A list of tools that run the
command you typed appears.

5. Double-click a tool to start it.

The dialog box for the tool
appears.

Finding a tool with a
keyword

1. Click the Tools menu and
click Find.

2. Click the Keyword tab.

3. Type a keyword in the
Keyword text box.

4. Click Find Now.

A list of tools containing the
keyword you typed appears.

5. Double-click a tool to start it.

The dialog box for the tool
appears.

Tip

Using Help to get more
information on a tool
You can use the ArcToolbox online
Help system to get information
when searching for a tool. When a
list of tools appears in the Find
dialog box, you can right-click a
tool name and click Help. For
instructions on how to use Help,
see �Getting help� in this chapter.

2 3

4

List of tools that run the command
you typed in the text box

2 3

4

List of tools containing the keyword
you typed
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Getting help
A quick way to learn about the
tools and wizards in ArcToolbox
is to use the online Help
system. You can get help in
ArcToolbox in a variety of
ways.

Each toolset in the ArcToolbox
tree has a Help node with
information about the tools and
wizards contained within it.
Double-clicking the node
displays an overview of what
each tool or wizard does.

If you want more detailed
information about a tool or
wizard without actually starting
it, you can choose Help from its
context menu to open its Help
file.

You can also get help in tool
dialog boxes. When you click
the What�s This? button in the
upper-right corner and click an
item in the dialog box, a
description of the item pops up.
Tool and wizard dialog boxes
also have a second Help
button; clicking it opens a Help
topic with detailed information
about the tool or wizard. u

Getting help using Help
nodes

1. Navigate to the toolset about
which you want information.

2. Double-click the Help node.

A Help window opens.

3. Click the Close button to
close the Help window.

3

2
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Much of the information in this
book is available in the Help
system. The Help topics are
organized around the main
tasks you wish to complete and
include some information about
the concepts behind the
tasks.

You can look up general Help
topics on the Contents tab of
the Help Topics dialog box. You
can search the index for specific
tasks and issues. You can also
use the Find tab to look up Help
topics that have specific words
or phrases.

Getting help in a dialog
box

1. Click the What’s This? button
in the dialog box.

2. With the Help pointer, click
the item in the dialog box
about which you want more
information.

3. Click anywhere on the
screen to close the Help
description box.

4. Click the Help button to view
more detailed information.

A Help window with detailed
information appears.

5. Click the Close button to
close the Help window.

Getting help using a tool
or wizard’s context menu

1. Navigate to the tool or wizard
about which you want
detailed information.

2. Right-click the tool or wizard
and click Help.

A Help window with informa-
tion about the tool or wizard
appears.

3. Click the Close button to
close the Help window.

Tip

Tips for toolsets, tools, and
wizards
When you click a toolset, tool, or
wizard, a description of what it
does appears in the status bar at
the bottom of the ArcToolbox
window.

2

12

4

Help window with detailed
information about the item
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Using the Help Contents
to get help

1. Click Help and click ArcGIS
Help.

2. Click the Contents tab.

3. Double-click a book to see a
list of topics in that category.

Double-clicking an open
book closes its list.

4. Click the topic you want to
read.

Tip

Finding another Help topic
Several topics listed on the
Contents tab or in the index may be
of interest to you. After reading a
topic, click Help Topics at the top
of the dialog box to get back to the
Help Topics dialog box.

1

3

2 4
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Finding Help topics
containing specific
words

1. Click the Help menu and
click ArcGIS Help.

2. Click the Search tab.

3. Type the word that should be
contained in the topics you
want to find.

4. Click List Topics.

5. Click the topic you want to
see.

6. Click Display.

Searching the index for
help

1. Click the Help menu and click
ArcGIS Help.

2. Click the Index tab.

3. Type the subject about which
you want information.

4. Click the topic you want to
read.

5. Click Display.

If several topics are related to
your selection, the Topics
Found dialog box appears.

6. Click the topic you want to
see.

7. Click Display.

Tip

The first time you use Find
The first time you click the Find
tab, a setup wizard appears.
Choose the default settings and
click Finish to close the wizard.

23 4 6

4 5

2 3
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Coordinate precision refers to the mathematical exactness of a
coordinate and is based on the possible number of significant
digits that can be stored for each coordinate. ESRI datasets are
stored in either single- or double-precision coordinates. Single
precision stores up to seven significant digits for each coordi-
nate. This means that values of 4,999,999.6 units to 5,000,000.4
units are rounded off to 5,000,000 units when stored in single
precision. However, a value of 5,000,000.6 is rounded off to
5,000,001 units when stored in single precision. This discrepancy
can easily be avoided by using a double-precision coordinate
system. Double precision stores up to 15 significant digits
(typically 13 to 14) and retains a mathematical precision of much
less than one meter at a global extent. Note that mathematical
precision does not, by itself, define accuracy. It is, however, a
major factor in coverage resolution.

The computer can only discern a limited number of decimal
places, depending on the precision being used. For single-
precision coordinates, the computer assumes that values such as
1.2345678 and 1.23456789 are equal because numbers beyond the
seventh digit are ignored. You might imagine a very, very small
halo surrounding each coordinate that is equal to the resolution
of coordinate storage on the computer. Coordinates with overlap-
ping halos are seen by the computer to represent the same
location.

Coverages stored with either single- or double-precision coordi-
nates can be used interchangeably; for example, you can display
single- and double-precision coverages over each other, overlay
them, merge them, and so on. This capability, however, does not
replace the need to be clear and deliberate about how you
encode, store, and manage each coverage. Base your decision of
which type of precision to use on the desired level of coordinate
accuracy to be maintained for each coverage.

The coordinate systems for many map projections use large
coordinate values�for example, State Plane and UTM coordi-

The precision environment

nates contain values in the two million to six million range. In
these cases, you can use double-precision coordinates to
maintain accuracy of less than one unit beyond the decimal point.

As mentioned, double-precision coverages can store up to
15 significant digits. This is sufficient to map any point on the
earth to better than a millimeter of accuracy. However, double-
precision coverages require additional storage space. Thus, it
may be worthwhile to store coverages that require high levels of
accuracy (such as parcels) in a double-precision coordinate
system and coverages needing less accuracy (such as soils) in a
single-precision coordinate system.

The Precision tab in the Options dialog box defines the coordi-
nate precision of new and derived coverages created during an
ArcToolbox session. The tab establishes two rules: creation and
processing.

The creation rule specifies the precision with which to create all
new coverages. Any time a new coverage is created, the coordi-
nate precision of the new coverage is defined by the current
creation rule. Single precision is the default. Thus, if you want to
create double-precision coverages, you must set the precision of
a new dataset to double.

The processing rule specifies the precision with which to create
all derived coverages. When a new coverage is derived from one
or more existing coverages (for example, the result of the Buffer or
Update tools), the coordinate precision of the new coverage
reflects the current processing rule. For example, the output
coverage precision can be the highest of a set of input coverages.
Thus, if all input coverages are in a single-precision coordinate
system, the output coverage will be single precision; if at least
one of the coverages is double precision, the output coverage is
double precision, and so on. To create double-precision cover-
ages regardless of the precision of the input coverages, set the
processing rule to double before you begin.
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Setting the
precision
Before you begin using the
tools in ArcToolbox, you
should determine what the
precision of your output
coverages should be. Be careful
not to use more precision than
is necessary, as the higher the
precision setting, the more disk
space you will need to store it.

It is probably best to use a
double-precision coordinate
system if the coordinate
resolution of a coverage must
be maintained past six signifi-
cant digits. Here are some of the
conditions that meet this
requirement:

� Your coverage requires a
high level of accuracy�for
example, a parcels layer.

� You need to use a map
projection whose coordinate
values exceed the available
coordinate precision.

� You are changing datums�
for example, from NAD27 to
NAD83.

1. Click Tools and click Options.

2. Click the Precision tab.

3. Click the appropriate
precision options.

4. Click OK.

1

2

4

3
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The ability to store related information in tables is an example of
the flexibility of ArcToobox. Attribute data can be stored in
feature attribute tables, related files, or external database man-
agement system (DBMS) tables.

You can also temporarily associate additional attribute tables with
a coverage�s feature attribute table using an operation known as a
relate. A relate makes a connection between a record in the feature
attribute table and a corresponding record in the related attribute
table. An item in one table is used as a relate key to a correspond-
ing item or column in the related table.

The relate is a defined and named relational join between feature
attribute tables, INFO files, and external DBMS tables. The relate
environment exploits all the advantages of a relational data
structure. In ArcToolbox, a relate is a named relationship between
an item appearing in a feature attribute table (or many tables) and
a related INFO datafile or external attribute table. A relate consists
of:

� A relation name�used to identify and access the relate.

� A table identifier�identifies the related table to be accessed.
This can be an INFO file,  table, or view in an external DBMS.

� A database name�identifies the DBMS in which the table is
stored (for example, INFO or a connection to one of the
supported external DBMS systems).

� An item�item in the feature attribute table or INFO file that
relates to the related table.

� A relate column�the item or column name in the related
attribute table that relates back to the feature attribute table or
INFO file item.

� A relate type�specifies the type of connection made and
depends on the database being interfaced. For INFO access,
type can be Linear, Ordered, or Link; for DBMS tables, it must
be First.

� A relate access�specifies the mode of access (for example,
RW, RO, or AUTO).

No specific source table name is stored as part of the relate;
relates are item based, not table based. This way, the same relate
can be used to relate more than one feature attribute table to the
related table.

To establish the relate environment, use the Relate Manager.
Once a relate is active, the related items are displayed in all lists
of available items when the relate is applicable to the currently
selected table or coverage feature class. For example, if a relate is
defined for a standalone INFO table that relates to a coverage�s
arc attribute table (AAT) and the Query Builder is used to select
records from that AAT, the list of available items will display
related items contained in that standalone INFO table.

Using relates

An example of a simple relate
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Defining relates
Related tables are accessed by
the Query Builder. This is used
by a number of tools that offer
the option of an attribute
selection such as the Select tool
or Extract Wizard. Your relate is
maintained by ArcToolbox, so
you need only define the relate
once.

You can define up to
100 different relates as part of
the relate environment at any
time. However, only 30 can be
used simultaneously during an
operation. Once the relate
environment contains
100 relates, you can�t replace a
relate with a new relate.
However, you can either update
the parameters of an existing
relate or delete a relate and
define another.

Defining a relate

1. Click Tools and click Relate
Manager.

2. Fill in the fields with the
required information.

3. Click the Add button to finish
the relate and make it active.

4. Click OK.

3

2

4

1
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Saving and restoring
relates

1. Click Tools and click Relate
Manager.

2. Fill in the fields with the
required information.

3. Click the Add button to finish
the relate and make it active.

4. Click the Save button to open
a browser.

5. Type a filename and click OK.

6. Click the Open button and
click the file just saved.

7. Click OK.

4

6
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Using ArcCatalog

ArcCatalog provides a different approach to managing your data. ArcToolbox works in conjunction with ArcCatalog,
providing an easy and efficient way to work.

ArcCatalog helps you browse, find, and manage data. You can
search for the data you wish to use and preview it. ArcCatalog is
the ideal application for managing your datasets and works in
conjunction with ArcToolbox.

ArcToolbox provides browsers for all inputs and outputs of each
tool, but you may find it easier to locate data and manage your
projects using ArcCatalog. Once you have found your dataset in

ArcCatalog, you can drag it to the appropriate text box in an
ArcToolbox tool using your mouse.

You can start ArcToolbox from ArcCatalog using the Launch
ArcToolbox button on the Standard toolbar. Data resulting from
operations performed with ArcToolbox tools is available in
ArcCatalog; you can see it once a tool has successfully com-
pleted its task and the ArcCatalog tree has been refreshed.

04Ch03.p65 11/29/2000, 3:41 PM43



44 USING ARCTOOLBOX

Tip

Using Windows Explorer
Datasets and files can also be
dragged onto tools from Windows
Explorer when the required access
is read-only. For example, you can
drag a coverage folder onto a text
box on the Union tool; however,
you can�t drag a coverage from
Windows Explorer onto the Build
tool, as the tool requires write
access to the coverage. Multiple
datasets and files can also be
dragged and dropped from
Windows Explorer.

Dragging and
dropping data
With ArcCatalog, you can
easily locate datasets you wish
to use for geoprocessing in
ArcToolbox. One way of
moving the data from
ArcCatalog to ArcToolbox is by
dragging and dropping it. To
drag and drop a dataset, simply
click the dataset in ArcCatalog
and drag it to the tool while
holding down the left mouse
button. Release the mouse
button and drop the dataset on
the correct text box. Dragging
and dropping more than one
dataset from ArcCatalog to a
tool opens the tool�s batch
table, allowing the tool to run in
batch mode and process all
datasets at once.

1. Start ArcCatalog from the
Start menu.

2. Click the Launch ArcToolbox
button to start ArcToolbox if it
is not already started.

3. In the ArcToolbox tree,
double-click a tool to start it.

4. In ArcCatalog, navigate to a
dataset you wish to move.

5. Click and drag the dataset
and drop it on the input text
box of the tool.

6. Click OK to run the tool.

5

6

2
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Starting the batch table
from the tool

1. Start the tool from
ArcToolbox. Click Batch to
open the batch table.

2. Type a dataset name to
populate the first row in the
table.

3. If necessary, change the
default parameters by
clicking the Feature class
dropdown arrow and clicking
a new feature class.

4. Click the Add Row button to
create a new row in the batch
table.

5. Repeat steps 2 and 3 to
populate the second row of
the batch table.

6. Repeat the steps above until
all the datasets you want to
use have been added to the
table.

7. Click OK to run the tool.

Operating tools
in batch mode
You can run multiple jobs of a
tool at once using a tool�s
batch mode capability. When
batch mode is activated, the
tool expands to show a table
displaying the parameters of
each job.

The batch table can be acti-
vated in several ways. The first
is to activate it on the tool
itself. You can also activate a
batch table automatically when
you drag and drop multiple
records onto a tool from
ArcCatalog or select multiple
input datasets from a browser.

The Build tool is used in this
task as an example of the batch
mode capability applicable to
every tool in ArcToolbox. Keep
in mind that although the tools
look different from one another,
batch mode works the same for
all of them.

You may not always want to run
the tool after you have popu-
lated the batch table. You may
prefer to run the batch job at
another time such as at the end
of the day when your system is
not as busy. You may want to
stop working on a tool and
come back later to finish
populating the table. The batch
table makes this possible by u

4

1

2

3

7
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letting you save its contents to
an AML script.

You can edit the AML scripts
created by ArcToolbox, but this
is not recommended as it may
corrupt them. Rather, you
should append a script by
saving to one that already
exists. In so doing, you can
compose an AML that performs
many tasks.

You can load an AML that has
parameters from numerous
tools, but only the valid
parameters for the current tool
are loaded. When you save to
an AML, the tool�s parameters
are always appended to the
contents of the script if it
already exists. For example,
suppose an AML has entries
from the Build and Clean tools.
When it is loaded into the Build
tool, only the entries pertaining
to the Build tool are used, and
the rest are left out.

Within the My Tools toolset is
a tool that can run any AML
that starts at the Arc: prompt.
You can run any existing AML
in your organization or one you
have created using a tool.

Starting the batch table
from ArcCatalog

1. In ArcCatalog, click the first
dataset you want to process.

2. Hold the Shift key down and
click the other datasets you
want to process.

3. Double-click the tool in the
ArcToolbox tree to start it.

4. Arrange the ArcCatalog
window and the tool dialog
box so that both are showing.

5. Drag and drop the selected
items from ArcCatalog onto
the input text box of the tool.

6. Click OK to run the tool.

Editing the batch table

1. Click the row in the batch
table whose parameters you
want to edit.

2. If necessary, change the
default parameters by
clicking the Feature class
dropdown arrow and clicking
a new feature class.

3. Click OK when the batch
table is complete to run the
tool.

5

1

2

3
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Saving batch table
contents to a script

1. Follow steps 1 through 7 for
starting a batch table from a
tool.

2. Click the Save To Script
button to save the contents of
your batch table to a script.

3. Click the Open button and
click a script that already
exists for that tool. Click Save.

The batch table is populated
with the script’s parameters.

Tip

Saving your work
By creating a script each time you
run a tool in batch mode, you
create a log of what you have done.
This log, in the form of an AML
script, will help you if you need to
run the tool again or remind
yourself of the tools and parameter
values used to create a dataset.
This may not be necessary, but it is
an effective way of logging your
work.

Tip

Closing the batch table
You can close the batch table in a
tool by clicking the Single button in
the tool�s dialog box.

Deleting a row from the
batch table

1. Click the row you want to
delete from the table.

2. Click the Delete Row button.

The row is deleted from the
batch table.

2

32

The batch table is populated.

04Ch03.p65 11/29/2000, 3:41 PM47



48 USING ARCTOOLBOX

Saving a wizard’s
contents
The summary panel at the end
of each wizard has a button that
lets you save the contents of
the wizard to an AML script.
After you have gone through
all the panels of the wizard, you
can click Save to AML to save
the wizard�s contents for later
use.

This button also lets you create
a batch script that will run more
than one job with the wizard.
After you�ve saved the
contents of the wizard to an
AML script, you can save
subsequent inputs to the same
script.

You can�t import or edit a script
while using a wizard. Be sure
about the parameters you enter
before you save. You can
always go back to previous
steps in a wizard to check your
input and fix any mistakes.

1. Follow the steps on each
panel of the wizard.

2. Once you reach the summary
panel, click the Save to AML
button.

3. Type the name of an AML to
create or click an existing
AML in the browser.

4. Click OK.

2
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The Geoprocessing Server

ArcToolbox can perform remote processing on another machine
that has been set up as a Geoprocessing Server; this machine can
be either a Windows NT or UNIX system. The Geoprocessing
Server is installed separately from ArcToolbox and runs as a
separate application. For complete information about the installa-
tion of a Geoprocessing Server and how to enable Geoprocessing
Server client desktops, see Appendix B, the �Geoprocessing
Server Administration Guide� .

In ArcToolbox, you can connect to any machine that has been
activated as a server. After connecting to a server, you can
specify whether or not you want tasks to run remotely. This front-
and back-office approach lets you compose tasks on your
desktop but process the data where it resides, creating a more
efficient work environment.

Before you can process jobs remotely, you must add a server
name to a list of available servers. You must provide and verify
connection information before the server can become active on a
client desktop. Once a server is activated and chosen, all of the
ArcToolbox tasks run on the remote server. All subsequent tasks
run by ArcToolbox will use the remote server. You can�t run some
tasks locally and others remotely without changing the process-
ing state.

When you connect to a Geoprocessing Server, you must specify
the Geoprocessing Server instance running on the server you
want to use. An instance is one installation of the Geoprocessing
Server running on a host machine. Multiple Geoprocessing
Server instances may exist on one server, so an instance name
identifies the installation you want to use. Your desktop computer
can communicate with an instance once the instance name and its
communication information is specified in your Windows services
file.

The Geoprocessing Server manages the jobs you post to the
server and sends you the results of the job when it is complete.

Typically, the job order is decided by the first in, first out rule, but
you can also specify when a job should run using the scheduling
option of the server. You may schedule your jobs to maximize
efficiency on your server and complete tasks when their results
are needed.

Only AML scripts that execute nongraphic commands available
in the ARC module are supported by the Geoprocessing Server.
This means the AML you use can�t switch from one module to
another. For example, you can�t run an AML that starts in ARC
and then switches to ARCPLOT� software to start a display
canvas. Using the Run AML Script tool, you can run existing
AMLs from ArcToolbox and have them processed anywhere you
like.

The following pages show you how to connect to a
Geoprocessing Server, send and schedule jobs, and check for
results.
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Tip

Where is your data?
If your data is located on a remote
system that has superior resources,
such as a faster CPU, make it a
Geoprocessing Server and process
your data there instead of on a
desktop client. This is a great way
to take advantage of your powerful
UNIX system.

Setting your processing
environment

1. Click Tools and click Remote
Processing.

2. Click the Settings tab.

3. Check the first check box to
process jobs on a remote
Geoprocessing Server.

4. Click the dropdown arrow
and click a Geoprocessing
Server. If the list is empty,
follow the steps below to
connect to a server.

5. Click OK.

Using a
Geoprocessing
Server
Before you can submit a job to
a Geoprocessing Server, you
must set your processing
environment and create a
connection to a Geoprocessing
Server instance. Once this is
done, all jobs will be submitted
to the server.

Connecting to a
Geoprocessing Server

1. Click the Tools menu and
click Remote Processing.

2. Click Define.

3. Type the connection informa-
tion in the text boxes.

4. Click OK.

1

3

4
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Connection
properties
Once you have specified the
properties of a Geoprocessing
Server connection, you can test
the connection to ensure the
connection is valid. If one or
more of the connection proper-
ties are incorrect, you can
change them using the Connec-
tion Properties dialog box.

Testing your connection

1. Click the Tools menu and
click Remote Processing.

2. Check the first check box to
Process jobs on a remote
Geoprocessing Server.

3. Click the dropdown arrow
and click a Geoprocessing
Server. If the list is empty,
follow the steps for connect-
ing to a Geoprocessing
Server to define a server.

4. Click Test.

The cursor will change to an
hourglass while the test is
being executed. The connec-
tion is valid if the cursor
changes back to the default
and the test button becomes
disabled. If the connection is
invalid an error message
describing the problem will
be displayed.

5. Click OK.

Changing properties

1. Click Properties.

2. Edit the properties of the
currently selected connec-
tion. A password is always
required when defining
connection properties.

3. Click OK.

4. Click Test to validate the
connection.

3

2 4
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Checking a
remote process
Once a job has been sent to a
Geoprocessing Server from a
tool or wizard, the client can
request the status of the job.
When you send a job to the
server, the server gives you a
job ID to identify the job. When
you check the status of a job,
the Geoprocessing Server tells
you whether the job is sched-
uled, is processing, was
completed, or has failed. The
status of each job submitted to
the server is displayed in a
dynamic list started from
ArcToolbox. Once a job has
been completed, you can view
the messages that occurred
during the job�s processing.
Completed job records can then
be deleted from the list in order
to keep the list current.

1. Click Tools and click Remote
Processing.

2. Click the Jobs tab.

3. Click any scheduled job in
the list.

4. Click Refresh to update the
list. Continue to periodically
update the list until the job is
completed.

5. Click Result to see the
messages from the server
regarding the job.

6. Click Remove to remove the
entry from the list.

7. Click OK.
2

3

74 5 6
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Tip

Scheduling a
remote process
Once you choose to schedule
all of your remote processes,
you are asked to submit a time
when the job will be sent to the
Geoprocessing Server. Once a
remotely scheduled process is
submitted, the server manages
its schedule and reports the
status of the process back to
the ArcToolbox client.

Activating scheduling

1. Click Tools and click Remote
Processing.

2. Click the Settings tab.

3. Check the second check box
to Always schedule remote
Geoprocessing requests.

4. Click OK.

Scheduling a job

1. Click the Date dropdown
arrow and click a date. The
current date is the default.

2. Click the up and down
arrows on the Time text box
or type the desired start time.
(You must select the hour,
minute, or second sections
first when using the arrows.)

3. If you don’t want to schedule
future jobs, check the check
box so that the dialog box is
not shown in the future and
all jobs are processed
immediately.

4. Click OK.

Tip

Synchronize your clocks
It is important to synchronize the
clocks on the server and the client
machines in order to accurately
schedule remote processes.
Differences in time may cause
confusion, especially when multiple
people are trying to schedule jobs
during assigned times.

1

23

4

3

2

4
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Creating your own look 4
• Turning off toolsets and tools

• Turning off Help nodes and tool
descriptions

• Adding to the My Tools toolset

• Placing tools on top

As you use ArcToolbox, you may notice that you are only using tools from a
few specific toolsets or that you are using tools from numerous toolsets to
complete a routine task. You may not want to navigate through all of these
toolsets to find the tools you commonly use. To make your work easier,
ArcToolbox offers a way to personalize the organization of your tools. You
can customize the ArcToolbox tree so that only the toolsets and tools you
need are visible, thereby creating your own look and feel.

In Chapter 2, you were introduced to the My Tools toolset and learned how it
can serve as your custom work area. In this chapter, you will create custom
toolsets and add preexisting tools. You will also learn how to change the
choices available in the Data Management Tools, Analysis Tools, and Con-
version Tools toolsets, eliminating those tools you do not use. This will help
you find the tools you want more efficiently.
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Turning off
toolsets and tools
To simplify your work with
ArcToolbox, you can turn off
toolsets and tools in the first
three toolsets in the
ArcToolbox tree. (The My
Tools toolset is already
completely customizable.) You
may want to turn off unwanted
or infrequently used tools so
that they don�t clutter the tree.

This feature is also very helpful
when you want to create a
custom interface for performing
specific tasks. You can control
what users can do with
ArcToolbox by customizing the
interface based on the tasks
each individual is assigned to
do.

If you are an administrator, you
now have more control over
how the software is used. You
can turn off a tool when you
don�t want it available to users.
For example, if you don�t want
your data cleaned, you can turn
off the Clean tool.

1. Click Tools and click Options.

2. Navigate to the toolset or tool
you want to turn off.

3. Uncheck the toolset or tool to
turn it off.

4. Repeat steps 2 and 3 until
you are finished turning off all
of the toolsets and tools you
don’t want.

5. Click Apply to apply the
changes without closing the
Options dialog box.

6. Verify the changes you made
in the ArcToolbox tree.

7. Click OK to close the Options
dialog box.

1

3

7 5
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Turning off tool
descriptions and
Help nodes
After using ArcToolbox for a
while, you�ll learn what the
tools do, the purpose of each
toolset, and what tools they
contain. You may want to
reduce the space needed to
display this information, giving
you more space on your screen.

Help nodes and tool descrip-
tions are turned on by default
to help you become familiar
with ArcToolbox. By turning off
the tool descriptions, you
eliminate the text at the bottom
of the ArcToolbox window that
describes the item currently
selected in the ArcToolbox tree.
When Help nodes are turned
off, only the tools or toolsets
contained in each main toolset
are displayed.

Turning off tool
descriptions

1. Click the Tools menu and
click Options.

2. Uncheck the the first option to
turn off the tool description at
the base of ArcToolbox.

3. Click OK to apply the property
and close the dialog box.

Turning off Help nodes

1. Click the Tools menu and
click Options.

2. Navigate to the Help node
you want to turn off.

3. Uncheck the Help node to
turn it off.

4. Click OK to apply the
property and close the dialog
box.

2 3

4

3
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Adding to the My
Tools toolset
As discussed in Chapter 3, the
My Tools toolset is designed to
be customized to simplify your
work. This involves adding
frequently used tools or tools
associated with a common task.
An easy way to add tools to the
My Tools toolset�or to a
custom toolset you create
within it�is to send them from
their original location in the
ArcToolbox tree. This is done
using the Send to command in
the tool�s context menu.

The context menu initially gives
you the option of sending tools
only to the My Tools toolset.
However, you can also create
custom toolsets within My
Tools to organize the tools you
use most frequently. You can
then send the tools to the
appropriate toolset. Once added
to My Tools, the custom
toolsets� names appear auto-
matically in the Send to list.

Sending tools to the My
Tools toolset

1. Navigate to the tool you want
to send.

2. Right-click the tool, point to
Send to, and click My Tools.

3. Double-click My Tools.

4. Right-click the tool you sent
and click Rename.

5. Type a name describing the
tool.

6. Click OK.

The tool appears under My
Tools.

2

5

6

4

3

Tip

Deleting a tool or custom
toolset from My Tools
To delete a tool or custom toolset,
right-click the tool or toolset and
click Delete.
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Adding a custom toolset

1. Right-click My Tools and click
Add toolset.

2. Type a name for the custom
toolset and click OK.

3. Navigate to the tool you want
to add to the custom toolset.

4. Right-click the tool, point to
Send to, and click the custom
toolset to which you want to
add the tool.

5. Double-click the My Tools
toolset.

6. Double-click the custom
toolset to see the tool you
added. 2

4

Tip

What’s in a name?
Give your custom toolsets names
that clearly specify the types of
tools found within them. You can
use up to 66 characters in the
name, so use as many words as it
takes to clearly describe the
toolset�s purpose.

1
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Placing tools on
top
Sometimes you need to use
several dialog boxes and
windows at the same time�for
example, when you are dragging
and dropping datasets from
ArcCatalog onto a tool from
ArcToolbox. Often when you
are doing this, tool dialog boxes
get lost behind windows of
other applications, especially
when you have a small screen.

ArcToolbox has an option to
place tools on top to make
these tasks easier. Once this
property is set and applied, all
tool dialog boxes remain �on
top� of windows from other
applications. However, it�s
important to set this property
before you start using a tool as
it won�t affect tools that have
already been started.

1. Click Tools and click Options.

2. Check Place tools on top.

3. Click OK to apply the prop-
erty and close the dialog box. 1

32
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Adding a custom tool 5
• Requirements for a custom tool

• Creating a custom tool in Visual
Basic 6.0

• Enabling drag and drop

• Adding a custom tool

Although ArcToolbox provides a long list of tools, you may want to add to its
capabilities so that you can perform additional tasks. You can do so by
developing and installing new tools to meet your requirements.

A custom tool can be a system executable (EXE) or a class contained in a
dynamic link library (DLL). The executable tool can run any application
that runs on the platform you�re using. This could be a word processor,
spreadsheet, or computer-aided design (CAD) application that supplements
your use of ArcToolbox. If you have a DLL, it must meet some simple
requirements in order for it to work.

In this chapter, you will learn how to create a very simple custom tool and
add it to ArcToolbox. The example in this chapter uses Visual Basic 6.0 as
the development environment, but you could use any developer environment,
such as Visual C++®, Delphi®, or Sybase® PowerBuilder®, to construct a
custom tool EXE or DLL.

The custom tool must be fully self-contained. ArcToolbox provides only the
Arc automation server, which allows access to the full range of functions in
the ARC module. The tool must handle all validation, execution, and error
checking.
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When creating and adding custom tools, certain requirements
must be met. These requirements depend on the type of custom
tool you�re working with: DLL or EXE.

DLL

Every DLL that is installed as a custom tool must have a class
that implements the IArcToolBoxTool Component Object Model
(COM) interface. This interface provides ArcToolbox with the
information it needs to store and execute the tool from the
ArcToolbox tree. Custom tools must also support the
IArcToolboxFind interface if the tool is to be supported by the
ArcToolbox Find tool. The  IArcToolboxFind interface provides
information required by the Find tool such as keywords and what
ARC commands are used. If the custom tool references the ODE
Arc automation server, then it should implement the
IArcToolBoxODE interface so it can use the Arc automation
server defined in the ArcToolbox application�this saves
resources and  improves performance. You can learn more about
these interfaces by using the ESRI Object browser or the VB
Object Browser.

The class can be called whatever you want. For an example of a
class definition that meets the above requirements, refer to the
example in Appendix A. In this example, a VB form called
frmDescribe is opened from inside the class.

Executables

There are no requirements for executables used as ArcToolbox
custom tools, except that the executable must operate in the
current operating environment and handle its own errors and
validation. For example, you could add ArcCatalog as a custom
tool simply by using the executable found in its installation
directory.

Requirements for a custom tool
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Creating a
custom tool in
Visual Basic 6.0
You can create a custom tool for
ArcToolbox using
Visual Basic 6.0. This involves
calling a VB form from a VB
class. In this example, the form
has a text box for the name of a
dataset, which is then described
using the ArcInfo Describe
command. The results are then
displayed in a list box on the
form.

The sample tool in this example
uses ArcInfo ODE, but you are
not limited to this type of tool.
You can create any type of tool
you want using third-party
ActiveX technology. You can
build a report writer, CAD
viewer, or anything else that
may help you use ArcToolbox.

Creating a VB class

1. Open Visual Basic 6.0 and
double-click ActiveX DLL.

2. Click the Project menu and
click References.

3. In the References dialog box,
check ESRI Arc automation
server, ESRIUtil automation
server, ESRI Object Library,
ESRI ArcToolbox Graphic
Resource Library, and ESRI
ArcToolbox Interfaces. Click
OK.

4. Click the Name property for
the class module and type
“clsDescribe” as its new
name.

5. See Appendix A for Visual
Basic code for the class. Type
the code or copy and paste it
from the online Help system.
Add the code to the code
window.

6.  Click the File menu and click
Save Project As. Type
“describe.cls” to name the
class. Click Save.

6

1

3
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Creating a tool form

1. In Visual Basic, click Project
and click Add Form. Add a
regular form and set its name
property to “frmDescribe”. Set
the caption property to
“Describe”.

2. Add a text box, list box, label,
and two button controls by
clicking the appropriate
buttons on the General
toolbar and placing them on
the tool form.

3.  Name the controls as follows:

list1 = lstOutput
command1 = cmdOK
command2 = cmdCancel
label1 = lblInput
text1 = txtInput

4. Type “OK” into the caption
property of cmdOK and type
“Cancel” in the caption
property of cmdCancel.

5. Make the text property of the
txtInput text box blank and
type “Input dataset:” in the
caption property of lblInput.  u

See Also

For more information on develop-
ing custom tools with ArcInfo
ODE, see Working with the
ArcInfo Open Development
Environment: ActiveX Controls
and Automation Servers for
Windows NT Developers.

2

1

2
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6. Click the Alphabetic tab in
the Properties - IstOutput
dialog box. Type “8655” for
the Width field. Change the
font to 8 pt. Courier New.
Widen the form to accommo-
date the size of lstOutput by
simply dragging the sides of
the form or by setting the
form’s width property.

7. Click the File menu and click
Save frmDescribe As. Type
“describe.frm” as the form file
name.

8. Click the File menu and click
Save Project As. Type
“Describe” in the Project File
box.

9. Refer to Appendix A for
Visual Basic code for the
form. You can also copy and
paste the code from the
online Help system.

10. Click the Save button and
save the form and the
project. u

Tip

Naming controls
When naming your VB controls,
use prefixes to help distinguish the
type of control being used. For
example, all text boxes on a form
would start with �txt�. You should
choose appropriate prefixes and
use them consistently.

6

Q
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11. Click the File menu and click
Make Describe.dll.

If errors occur, review the
code to make sure it exactly
matches what is in
Appendix A. Create the DLL
in the same location as your
project.

12. Exit or minimize Visual
Basic.

W
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Tip

Validating your input and
output
To make a robust tool, you should
include routines to validate the
input and output of your tool. Make
sure the input is the type you need
and that, if the output already
exists, the tool will address the
issue by displaying an appropriate
message.

Enabling drag
and drop
All ArcToolbox tools accept
data that is dragged and
dropped from ArcCatalog or
Windows Explorer. Your custom
tool should also offer this
feature, as it�s an easy and
efficient method of adding input
to tools. You can add the drag-
and-drop capability to your
custom tool using a VB form.

Unlike Windows Explorer,
ArcCatalog doesn�t simply
provide a string containing a
dataset�s path. Instead, it
provides an object that con-
tains the path and its type.

Due to this difference, enabling
drag and drop from ArcCatalog
requires more from you such as
handling the type of object
being passed to a tool. u

Enabling drag and drop
from Windows Explorer

1. Open your project in Visual
Basic 5.0 or 6.0.

2. Select the form and input text
box you want to enable.

In the sample code, the text
box is named txtInput.
Change the code to match
your text box name or
rename your text box to
match the code.

3. Click the OLEDropMode
dropdown arrow and click
1 - Manual.

4. Refer to Appendix A for the
VB code that enables drag
and drop from Windows
Explorer. You can also copy
and paste the code from the
online Help system.

If you already have a routine
for OLE drag and drop,
simply update it with the
example routine; otherwise,
place it at the end of your VB
form’s code window. Save the
form.

5. Create a new DLL or EXE.

3
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Enabling drag and drop
from ArcCatalog

1. Open your project in Visual
Basic 5.0 or 6.0.

2. Select the form and input text
box you want to enable.

In the sample code, the text
box is named txtInput.
Change the code to match
your text box name or
rename your text box to
match the code.

3. Click the OLEDropMode
dropdown arrow and click
1 - Manual.

4. Refer to Appendix A for the
VB code that enables drag
and drop from ArcCatalog.
You can also copy and paste
the code from the online Help
system.

Place the code at the end of
your VB form’s code window.
Save the form.

5. Create a new DLL or EXE.

3

ArcCatalog also provides much
more information than Windows
Explorer, allowing you to filter
which datasets can and can�t be
dropped onto a control. Name
objects are supplied when you
either drag and drop a dataset
from ArcCatalog or use the
ArcCatalog browser.

06Ch05.p65 11/29/2000, 3:50 PM68



ADDING A CUSTOM TOOL 69

Adding a custom
tool
Custom tools from DLLs are
added to ArcToolbox using the
RegCat utility found in your
$ARCHOME\bin folder. This
executable registers all custom
tools in the DLL with your
ArcToolbox application. On
startup, the ArcToolbox scans
the registry for all the registered
tools and displays them in the
tree. RegCat may also be used
to unregister (remove) tools
with ArcToolbox.

Custom tools in the form of
system executables can be
added to the tree by running
the Add Custom EXE Wizard
found in the My Tools toolset.
These EXE-based tools must be
added to the My Tools toolset
or to a custom toolset found
within My Tools. There is no
such restriction with tools
compiled into DLLs.

RegCat may be used either as a
standalone executable from a
command prompt or as a
desktop tool. To see the
standalone usage, type �regcat
-h� at a command prompt. To
use RegCat as a desktop tool,
create a windows shortcut and
add it to your desktop. Simply
drag and drop DLLs from
Windows Explorer onto the
Regcat icon, then click the u

Adding a DLL

1. Open Windows Explorer and
click the DLL you want to
register with ArcToolbox.

2. Drag the DLL from Windows
Explorer and drop it onto the
RegCat icon on your desk-
top.

3. Check ArcToolbox and click
Register.

2

3
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Tip

Managing custom tools
The location of a custom tool�s
DLL or EXE file should be write-
protected to ensure that it isn�t
mistakenly deleted. If a custom
tool�s file is not found, a message
notifies you that the tool can�t be
started as it can�t be found. Create
a directory specifically for custom
tools and store the files there.

Adding an executable

1. Double-click My Tools and
double-click Add a Custom
EXE Wizard.

2. Click the Browse button and
navigate to the executable
you want to install. Click
Open, then click Next on the
wizard.

3. Click the dropdown arrow
and click the toolset in which
you want the new tool to
appear. Click Next.

Custom EXE tools may be
added to the My Tools toolset
or any other custom toolset
you have already created in
My Tools.

4. If the EXE requires one or
more arguments, specify
them and click Next. If it does
not, click Next. u

Tip

Deleting a custom tool
You can delete a custom tool by
right-clicking the tool in the
ArcToolbox tree and clicking Delete
if it is a custom EXE or by
unregistering the DLL that
contains the tool using RegCat.

1

2

3

See Also

For more information on the My
Tools toolset and creating toolsets
for My Tools, see Chapter 4,
�Creating your own look�.

appropriate application. This
example uses RegCat as a
desktop tool.
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Tip

Names, descriptions, and
keywords
Always give your new tools names
that indicate their function. Include
detailed yet concise descriptions
and give a minimum of four
keywords that you feel best
describe your tool�s function. This
is very important if several people
will be using the tool.

7

8

5. Type the name of your tool in
the appropriate text boxes.
Click Next.

6. Give a description of the tool.
Click Next.

7. If the tool uses the ARC
module of ArcInfo Worksta-
tion, type the ArcInfo com-
mand or commands that are
utilized.

8. Type several keywords that
may be used to find the tool
using the ArcToolbox Find
tool. Use a comma to
separate each keyword. Click
Next.

9. If you want to provide a help
document from the tool’s
context menu, type a helpfile
and a help context ID in the
text box and click Next;
otherwise, simply click Next.

10. Review the summary panel
to ensure the information is
correct. Click Finish.

5

6
Manages and previews all ESRI datasets.
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73

Appendix

• VB code for a custom tool class

• VB code for a custom tool form

• Enabling drag and drop in a text
box for ArcCatalog

• Enabling drag and drop in a text
box for Windows Explorer

The Visual Basic samples found in this appendix are also available in the
�Adding custom tools� section of the ArcToolbox online Help system. Use
those samples for copying and pasting into Visual Basic.

A
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' Describe.cls

' ESRI example for creating a custom tool for the ArcToolbox

Option Explicit

' Implement the necessary interfaces for a tool. IArcToolboxTool is required

' for all tools.

Implements IArcToolboxTool

' IArcToolboxFind is required if you want to use the Find tool to locate

' your tool.

Implements IArcToolboxFind

' IArcToolboxODE is required if your tool uses the Arc Automation server to

' execute an Arc command.

Implements IArcToolboxODE

' Define a member variable to reference the Arc automation server

' passed to the class from the IArcToolboxODE interface.

Private m_Arc As ESRI.Arc

' Define member variable for the modality setting.

Private m_Modality As AtModality

' Define a bitmap object for the tree bitmap.

Private m_Bitmap As IPictureDisp

Private Sub Class_Initialize()

  ' Default the modality to MODAL.

  m_Modality = atModal

  ' Refer to the ArcToolbox Graphic resource library for a regular tool bitmap.

  ' For a wizard use a resource value of 15123. The help node bitmap value is 15119.

  Dim pGraRes As New ATGraRes.GraphicRes

  Set m_Bitmap = pGraRes.GetBMP(15122)

End Sub

VB code for a custom tool class
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Private Property Get IArcToolboxFind_ArcCommands() As String

  ' The Arc command used by the tool, if applicable.

  IArcToolboxFind_ArcCommands = "Describe"

End Property

Private Property Get IArcToolboxFind_Keywords() As String

  ' Keywords that may be used to identify the tool.

  IArcToolboxFind_Keywords = "describe,dataset,properties,features,list"

End Property

Private Property Get IArcToolboxTool_Bitmap() As Stdole.IPictureDisp

  ' Identifies the bitmap to display in the Toolbox tree.

  Set IArcToolboxTool_Bitmap = m_Bitmap

End Property

Private Sub IArcToolboxTool_Execute(Optional InputData As Variant)

  ' Pass Arc automation server to the tool form, then show the form

  ' with the modality setting.

  frmDescribe.ArcInit m_Arc

  frmDescribe.Show m_Modality

End Sub

Private Property Get IArcToolboxTool_HelpContextID() As Long

  ' This indicates the help ID in the help file for the tool.

End Property

Private Property Get IArcToolboxTool_HelpFile() As String

  ' The help file that contains the help context ID.

End Property
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Private Property Get IArcToolboxTool_Message() As String

  ' This is used at the base of the Toolbox to describe the tool when selected.

  IArcToolboxTool_Message = "Describes a dataset, resulting in a list of properties."

End Property

Private Property Get IArcToolboxTool_Modality() As esriCore.esriATModality

  ' Return if the tool is modal or modeless.

  IArcToolboxTool_Modality = IArcToolboxTool_Modality

End Property

Private Property Let IArcToolboxTool_Modality(ByVal RHS As esriCore.esriATModality)

  ' Set if the tool is modal or modeless.

  IArcToolboxTool_Modality = RHS

End Property

Private Property Get IArcToolboxTool_Name() As String

  ' The name of the tool or wizard in the ArcToolbox Tree.

  IArcToolboxTool_Name = "Describe"

End Property

Private Sub IArcToolboxTool_OnCreate(ByVal hook As Object)

  ' Use if you want access to the application itself.

End Sub

Private Property Get IArcToolboxTool_TreeviewLocation() As String

  ' This specifies where the tool lives in the ArcToolbox Tree.

  IArcToolboxTool_TreeviewLocation = "My Tools\Custom Tools"

End Property
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Private Property Set IArcToolBoxODE_ArcObject(ArcAutomationServer As ESRI.Arc)

  ' Identifies the Arc automation server used by the tool.

  Set m_Arc = ArcAutomationServer

End Property

Private Property Get IArcToolBoxODE_ArcObject() As ESRI.Arc

  ' Returns the Arc automation server used by the tool.

  Set IArcToolBoxODE_ArcObject = m_Arc

End Property
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' Describe.frm

' Example custom tool for ArcToolbox

' Define all variables and objects that are needed.

Option Explicit

Dim lngI As Long

Dim MyArc As ESRI.Arc

Dim MyEsriStrings As New ESRIutil.Strings

Dim lngSev As Long

Private Sub cmdCancel_Click()

  ' Unload the form when you press the Cancel button.

  Unload Me

End Sub

Public Function ArcInit(Optional AIControl As ESRI.Arc)

  ' Purpose: Passes in the automation server from ArcToolbox and shows tool GUI.

  If AIControl Is Nothing Then

    Set MyArc = New ESRI.Arc

  Else

    Set MyArc = AIControl

  End If

End Function

Private Sub cmdOK_Click()

  ' If the input text box does not contain any characters, display an error

  ' message and exit the subroutine.

  If Trim(txtInput) = "" Then

    MsgBox "You must provide a dataset name.", vbExclamation, Me.Caption

VB code for a custom tool form
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    Exit Sub

  End If

  ' If the text box does contain characters, disable the OK button to prevent

  ' message and exit the subroutine.

  If Trim(txtInput) = "" Then

    MsgBox "You must provide a dataset name.", vbExclamation, Me.Caption

    Exit Sub

  End If

  ' If the textbox does contain characters, disable the OK button to prevent

  ' reentrance. Push the string 'YES' into the Arc automation server's buffer

  ' so that it is used when the question 'Do you want to continue?' is asked

  ' by the DESCRIBE command.

  cmdOK.Enabled = False

  MyArc.PushString "YES"

  ' Run the command, setting a variable to contain the ARC Macro Language (AML) severity returned

  ' by the Arc automation server.

  lngSev = MyArc.Command("describe " & txtInput, MyEsriStrings)

  If lngSev = 2 Then

    ' If the severity is 2, the command failed. Display the error in a message

    ' box. Clear the strings collection and set the focus back to the input text

    ' field with all of the characters selected. Enable the OK button.

    MsgBox MyEsriStrings.Item(0), vbExclamation, "Error Occurred"

    MyEsriStrings.Clear

    txtInput.SetFocus

    txtInput.SelStart = 0

    txtInput.SelLength = Len(txtInput)

 End If

End Sub
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Private Sub Form_Unload(Cancel As Integer)

  ' Set the Arc automation server and the ESRI strings collection to nothing

  ' so that the objects are dropped from memory when the form closes. Set the

  ' entry in the registry so that ArcToolbox knows no other tool is running.

  Set MyArc = Nothing

  Set MyEsriStrings = Nothing

End Sub

Private Sub txtInput_KeyDown(KeyCode As Integer, Shift As Integer)

  ' If the user presses the Enter key, run the command by invoking the

  ' cmdOK click event.

  If KeyCode = 13 Then

    cmdOK_Click

  End If

End Sub
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Private Declare Function RegisterClipboardFormat Lib �user32� Alias _

�RegisterClipboardFormatA� (ByVal lpString As String) As Long

' Declare function that registers a new clipboard format. This

' format can then be used as a valid clipboard format.

Private Sub txtInput_OLEDragDrop(Data As DataObject, Effect As Long, _

Button As Integer, Shift As Integer, X As Single, Y As Single)

  ' With name objects, you must first determine if the data being

  ' dropped is a name object or a regular drop from Windows Explorer.

  ' If you want to support drag and drop from ArcCatalog and  Windows Explorer, add

  ' the Windows example to this subroutine. In other words,

  ' If Data.GetFormat(lngFormat) Then

  ' accept name object

  ' Else

  ' accept a string

  ' Declare variables.

  Dim lngFormat As Long

  Dim pNameFactory As INameFactory

  Dim varBytes As Variant

  Dim pEnumNames As IEnumName

  Dim pName As IName

  Effect = vbDropEffectCopy

  lngFormat = RegisterClipboardFormat(�ESRI Names�)

  'Convert to signed integer.

  If lngFormat > 32767 Then

    lngFormat = CInt(lngFormat - 65536)

Enabling drag and drop in a text box for ArcCatalog
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  End If

If Data.GetFormat(lngFormat) Then 'Name Object format from ArcCatalog

    'Unpackages dropped name objects.

    varBytes = Data.GetData(lngFormat)

    Set pNameFactory = New NameFactory

    Set pEnumNames = pNameFactory.UnpackageNames(varBytes)

    ' Populate the m_ValidData collection.

    pEnumNames.Reset

    Set pName = pEnumNames.Next

    If Not pName Is Nothing Then

      If InStr(1, pName.NameString, �Coverage�, vbTextCompare) > 0 And _

        InStr(1, pName.NameString, �FeatureClass�, vbTextCompare) > 0 Then

        txtInput = GetINFOFullPath(pName)

      ElseIf InStr(1, pName.NameString, �Coverage�, vbTextCompare) > 0 Then

        txtInput = GetDatasetFullPath(pName)

      ElseIf InStr(1, pName.NameString, �Info�, vbTextCompare) > 0 Then

        txtInput = GetINFOFullPath(pName)

      Else

        MsgBox �Input must be a coverage, coverage feature class, or INFO table.�, _

          vbExclamation + vbApplicationModal

      End If

    End If

  End If

  ' Clean up.

  Set pNameFactory = Nothing

  Set pEnumNames = Nothing

  Set pName = Nothing

End Sub
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Private Function GetDatasetFullPath(ByRef Name As IName) As String

  ' Returns the full path of a dataset name object.

  Dim pDatasetName As IDatasetName

  If TypeOf Name Is IDatasetName Then

    Set pDatasetName = Name

    If pDatasetName Is Nothing Then

      GetDatasetFullPath = ��

      Exit Function

    End If

    GetDatasetFullPath = pDatasetName.WorkspaceName.PathName & �\� & pDatasetName.Name

    Set pDatasetName = Nothing

  Else

    GetDatasetFullPath = ��

  End If

End Function

Private Function GetINFOFullPath(ByRef Name As IName) As String

  ' Returns the full path of a dataset name object.

  Dim strNameString As String

  Dim Pos As Integer

  Dim strPath As String

  Dim strTable As String

  Dim strCover As String

  strNameString = Name.NameString

 If InStr(1, strNameString, �FeatureClass =�, vbTextCompare) > 0 Then
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    ' Feature class

    ' In other words, ARCINFO: Workspace = d:\data\redlands\cov\; Coverage = uuu; FeatureClass = arc;

    Pos = InStr(1, strNameString, �;�, vbTextCompare)

    strPath = Mid(Left(strNameString, Pos - 1), 22)

    strNameString = Mid(strNameString, Pos + 13)

    Pos = InStr(1, strNameString, �;�, vbTextCompare)

    strCover = Mid(strNameString, 1, Pos - 1)

    strTable = Mid(strNameString, Pos + 17)

    strTable = Mid(strTable, 1, Len(strTable) - 1)

    Select Case UCase(strTable)

      Case �POINT�

        GetINFOFullPath = strPath & strCover & �.pat�

      Case �ARC�

        GetINFOFullPath = strPath & strCover & �.aat�

      Case �POLYGON�

        GetINFOFullPath = strPath & strCover & �.pat�

      Case �NODE�

        GetINFOFullPath = strPath & strCover & �.nat�

      Case �TIC�

        GetINFOFullPath = strPath & strCover & �.tic�

      Case Else

        Pos = InStr(1, strTable, �.�, vbTextCompare) + 1

        If InStr(1, UCase(strTable), �REGION�, vbTextCompare) > 0 Then

          GetINFOFullPath = strPath & strCover & �.pat� & Mid(strTable, Pos)

        ElseIf InStr(1, UCase(strTable), �ROUTE�, vbTextCompare) > 0 Then

          GetINFOFullPath = strPath & strCover & �.rat� & Mid(strTable, Pos)
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        ElseIf InStr(1, UCase(strTable), �SECTION�, vbTextCompare) > 0 Then

          GetINFOFullPath = strPath & strCover & �.sec� & Mid(strTable, Pos)

        ElseIf InStr(1, UCase(strTable), �ANNOTATION�, vbTextCompare) > 0 Then

          GetINFOFullPath = strPath & strCover & �.tat� & Mid(strTable, Pos)

        Else

          GetINFOFullPath = ��

        End If

    End Select

  ElseIf InStr(1, strNameString, �InfoTable =�, vbTextCompare) > 0 Then

    ' Standalone INFO table.

    ' In other words, ARCINFO: Workspace = d:\data\redlands\cov; InfoTable = monk1.add;

    Pos = InStr(1, strNameString, �;�, vbTextCompare)

    strPath = Mid(Left(strNameString, Pos - 1), 22)

    Pos = InStr(1, strNameString, �;�, vbTextCompare)

    strTable = Mid(strNameString, Pos + 14)

    strTable = Mid(strTable, 1, Len(strTable) - 1)

    GetINFOFullPath = strPath & �\� & strTable

  Else

    GetINFOFullPath = ��

  End If

End Function
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Private Sub txtInput_OLEDragDrop(Data As DataObject, Effect As Long, _

Button As Integer, Shift As Integer, X As Single, Y As Single)

  ' Set the contents of the text box to be blank and then set the

  ' text box to the value of the dataset being dropped.

  Dim strFile As String

  txtInput.Text = ""

  strFile = CStr(Data.Files.Item(1))

  txtInput.Text = strFile

End Sub

Enabling drag and drop in a text box for Windows Explorer
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IN THIS APPENDIX

• Starting the Geoprocessing Server

• Accessing data on UNIX or
Windows NT

• Setting server defaults

• Pausing, resuming, and shutting
down a service

• Adding another instance

• Troubleshooting server problems

Appendix

This appendix is the �Geoprocessing Server Administration Guide�. This
guide is intended to help administrators add, start, and stop a Geoprocessing
Server instance. Setting up a client requires you to have either administrator
or owner privileges.

B
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Starting the
Geoprocessing
Server
The following tasks show you
how to start the Geoprocessing
Server on a UNIX or Windows
NT system and how to configure
a client so that it can submit jobs
to a server.

You will need administrator
privileges to install the server.
Once the server has been
installed on a UNIX system, the
server must be started from the
same login account that installed
it. This account would have
ownership of the ARCHOME
directory.

The password specified when
creating the service on Windows
NT or starting the service on
UNIX will be the administrator
password for the service. This
password can be anything when
it is first used and can be
changed by stopping and starting
the service again with a new
password.

When the Geoprocessing Server
service is started, it searches the
system services file for a service
name that matches the service
name in the services.rqm file. If a
match is not found, an error is
returned to the UNIX prompt or
the event log in Windows NT.  u

Installing the
Geoprocessing Server as
a Windows NT service

1. Run the command line utility
%ARCHOME%\bin\gpservice.exe
at the DOS prompt. Click the
create option and a new
password. The default name
given for the instance is
esri_gpsvr.

Starting the
Geoprocessing Server
service on Windows NT

1. Open the Services dialog box
from the Windows NT Control
Panel.

2. Click Geoprocessing Server
Service(esri_gpsvr) and click
Start.

3. Click Close when the status
of the Geoprocessing Server
is “Started”.

1
%ARCHOME%\bin\gpservice -o create -p gps -H
D:\arcexe80 -i esri_gpsvr

Add the instance name to your server services file before you try to
start the service. The password “gps” was determined by an
administrator for this service. You can use any password you want.

3
2
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Starting the
Geoprocessing Server
on UNIX

1. Run the command line utility
$ARCHOME/bin/gpmon with
the start option and adminis-
trator password.

Once the server has been
installed on a UNIX system,
the server must be started
using the same login account
that installed it. This account
should have ownership of the
ARCHOME directory.

Updating service access
on HP-UX®

1. Copy the nsswitch.conf file
from the /usr/newconfig/etc
directory to the etc directory.

2. Edit the file and change the
line ‘services: nis files’ to
‘services: files nis’.

Updating service access
on IBM ® AIX®

1. Create the file netsvc.conf in
the etc directory.

2. Open the file and add the line
‘services=local,nis’.

3.  Save the file.

1 $ARCHOME/bin/gpmon -o start -p gpsWhen a match is found, a
background process called
giomgr starts. It listens to the
Transmission Control Protocol/
Internet Protocol (TCP/IP) port
number assigned to the service
name for user connection
requests.

The services.rqm file should
contain only one service name. If
more than one exists, then the
Geoprocessing Server will use
the first one it encounters.

If you are on UNIX, you must
change ownership of the
arcrqmgr executable located in
$ARCHOME/bin so that it is
owned by root. The permissions
for this executable must be set to
6755.

Some UNIX systems direct
applications to search the NIS
services file rather than the hosts.
You can force a search of the
local services file on these
systems so you can properly
administer the Geoprocessing
Server.

Specifying the server instance is not necessary on UNIX
unless multiple geoprocessing servers have been installed.

Tip

Using gpmon on
Windows NT
The gpmon utility is also available
on Windows NT in the
%ARCHOME%\bin directory. The
Geoprocessing Server instance can
be managed the same way on
Windows NT as on UNIX if you
prefer to use the command line.
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Enabling a client

1. Open the system services file
on the client machine. On
Windows NT, it is found in
C:\winnt\system32\
drivers\etc\, while on UNIX, it
is in /etc.

2. Add the name of the server
instance and its port number
to the file. To see the existing
server instance name and
port information, read the
%ARCHOME%\gpserver\
services.rqm file.

3. Save the file.

Accessing data
on UNIX or
Windows NT
If your data resides on a Win-
dows NT client machine, it must
be stored in a shared drive if it is
to be submitted to a
Geoprocessing Server. A user-
defined share name must be used
instead of the default share name.
For example, the default share
name C$ will not work, but
C_drive will.

Permissions must be set so that
the login used to create the
Geoprocessing Server connection
has the proper access to the data
being used in the Geoprocessing
Server job.

A UNIX Geoprocessing Server
requires that all data input and
output be from a UNIX directory
accessible from the UNIX server.
Data stored on Windows NT
should not be passed to a UNIX
Geoprocessing Server, as ESRI
does not support UNIX connec-
tions to Windows NT disks.

2

1
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Setting server
defaults
As a Geoprocessing Server
administrator, you can set the
maximum number of requests
that can be managed by the
server at one time. You can also
limit the number of server
processes that can be activated.
By setting the maximum number
of processes, you can control
how many jobs are executed
concurrently by the server.

A Geoprocessing Server only
uses one license at a time,
regardless of the number of jobs
being processed. If a license is
not available, requests are placed
in a queue until a license
becomes available. The queue
operates on a first in, first out
rule. Administrators can list or
update the contents of the queue
using the gpmon utility.

The allowable time difference in
seconds, which is the maximum
difference a client�s clock can
deviate from the server�s clock,
can also be set.

A path may be set to a location
where temporary disk space is
also available for the server.

Setting the maximum
number of requests

1. Open the rqmgr.defs file
located in $ARCHOME/
gpserver.

2. Change the maximum
number of requests as
desired.

3. Save the file and quit.

Setting the maximum
number of processes

1. Open the rqmgr.defs file
located in $ARCHOME/
gpserver.

2. Change the maximum
number of processes as
desired.

3. Save the file and quit.

Setting the maximum
time difference allowed

1. Open the rqmgr.defs file
located in $ARCHOME/
gpserver.

2. Set the maximum client/
server time difference
allowed as desired.

3. Save the file and quit.
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Setting a path to
temporary disk space

1. Open the rqmgr.defs file
located in ARCHOME/
gpserver.

2. Set the path to temporary
disk space.

All relative pathnames must
exist in the directory specified
by the environment variable
$ARCHOME; otherwise, an
absolute pathname must be
used.

3. Save the file and quit.

Listing requests on a
server

1. Run the gpmon utility with the
list option to display all
requests on a server.

Removing a submitted
request

1. Run the gpmon utility with the
remove option, specifying the
request ID you want removed.

         $ARCHOME/bin/gpmon -o list -p gps -t all1

         $ARCHOME/bin/gpmon -o remove -p gps -t 13

Tip

Temporary disk space
The result messages of each server
request are stored in the temporary
disk space location defined in the
rqmgr.defs file. In order to save
disk space and decrease the
number of active processes being
managed by the server, remove
request result messages from the
server when a job has completed
and when the result messages for
the job are no longer needed.
Remove these messages with the
gpmon utility or the Remote
Processing tab in ArcToolbox.

1

08AppB.p65 11/30/2000, 11:46 AM92



APPENDIX B 93

Pausing,
resuming, and
shutting down a
service
The Geoprocessing Server
manager has three modes:
running, paused, and shutdown.
When a server is running, clients
may submit a job. When paused,
current running jobs will
continue, but additional job
requests may not be submitted.
This is convenient when you
want to shut down the server but
want existing jobs to finish first.
Shutting down a server will
terminate all running jobs, and
new jobs cannot be submitted.
Shutting down also relinquishes
all server processes and operating
system resources.

Specify the server administrator
password that was created when
the service was started.

Pausing the server

1. Run the command line utility
$ARCHOME/bin/gpmon using
the pause option.

Resuming operation

1. Run the command line utility
$ARCHOME/bin/gpmon using
the resume option.

Shutting down a
Windows NT server

1. Open the Services dialog box
from the Windows NT Control
Panel.

2. Click Geoprocessing Server
service and click Stop.

3. Confirm that you want to stop
the service and click Close
when the status of the server
is blank.

Shutting down a UNIX
server

1. Run the command line utility
$ARCHOME/bin/gpmon using
the shutdown option.

1 $ARCHOME/bin/gpmon -o pause -p gps

$ARCHOME/bin/gpmon -o resume -p gps1

$ARCHOME/bin/gpmon -o shutdown -p gps1

2

3

Tip

Using a remote computer
To pause, resume, or stop the
service from a remote machine, on
UNIX or Windows NT, specify the
server and instance names when
running gpmon.
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Adding another
instance
You may want more than one
server instance running on one
machine. This is not recom-
mended on Windows NT, as you
must have two installations of
ArcInfo on one machine, making
ArcInfo administration more
difficult. On UNIX, you may
create another ArcInfo installa-
tion directory and create links for
all of the directories in the
existing ARCHOME directory
with the exception of the
gpserver directory. That directory
must be different and contain a
services.rqm file with another
instance name. It is helpful to
have another administrator
account to manage this new
ARCHOME directory.

To add a new instance, you must
update your system services file
and services.rqm file with the
new instance name and port
number. While the default port
number is 5262, you must ensure
that it is not already in use, as
port numbers must be unique.
This port number is not regis-
tered with the Internet Services
Institute/Internet Assigned
Numbers Authority, so it may
already be in use by another
application. If so, check your
system services file and add the
next unique ID.

Adding a Geoprocessing
Server instance on UNIX

1. Create a new directory that
will be your new ARCHOME
directory.

2. Add symbolic links to all
directories in your old
ARCHOME directory.

3. Delete the gpserver link and
copy the gpserver directory
from your old ARCHOME
directory to your new one.

4. Edit the services.rqm file in
the new ARCHOME/gpserver
directory to add the new
instance name and port
number.

5. Add the same instance and
port information to the system
services file on the server
(/etc/services).

6. Reset the ARCHOME
variable to point to the new
ArcInfo installation directory.
Source your .cshrc file to
reset any variables that use
the  ARCHOME variable.

7. Run the command line utility
$ARCHOME/bin/gpmon using
the Start option, then specify
the new instance name.

  esri% $ARCHOME/bin/gpmon -o start -p gps

1

2

3

  esri%  mkdir arcexe80.new

  esri%  ln -s /esri5/arcexe80/* arcexe80.new

  esri%  cd arcexe80.new

  esri%  rm -r gpserver

  esri%  cp  -r /esri5/arcexe80/gpserver gpserver

  setenv ARCHOME /esri5/arcexe80.new

  source ~/.cshrc

7

6
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Troubleshooting
server problems
The Geoprocessing Server has a
request server error log that
captures all of its errors. When a
command fails, consult this log
for helpful information.

Occasionally, you may not be
able to shut down an instance
due to hung processes or because
the instance itself has been
corrupted. These problems may
occur for various reasons such as
a system malfunction. In this
case, you can use the Killp utility
to stop the instance so you can
start a new one.

You may want to reset the server
so you can start it from its
original state. Doing this will
delete all submitted jobs and all
of the results currently residing
on the server. Only do this if you
are sure this information is not
required by anyone who previ-
ously submitted a job to the
server.

Reading the server
request error log

1. Open and read the file
rqmgr.err found in
%ARCHOME%\gpserver.

Killing the server process

1. Find the process ID of the
Geoprocessing Server. Use
the task manager on Win-
dows NT or use ‘ps -ef | grep
gp’ on UNIX.

2. Run the command line utility
%ARCHOME%\gpserver\killp
with the process ID to stop
the server instance.

Resetting the server

1. Stop the server if it is still
running (refer to ‘Shutting
down a Windows NT server’
or ‘Shutting down a UNIX
server’, earlier in this appen-
dix).

2. Delete the directory with the
same name as the instance
in the gpserver directory
located in ARCHOME.

3. Delete all of the files in the
tmp_results and aml directo-
ries also located in the
gpserver directory.

4. Start the server.

$ARCHOME/gpserver/killp 42702
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Common errors

This section outlines the causes and solutions to some errors you
may experience when using the Geoprocessing Server.

Unable to find results of a job submitted to a UNIX
server

I submit a job request to my remote Geoprocessing Server, and
the Remote Processing dialog box states that it is completed.
When I review the results of the job, I see something similar to
this:

AML ERROR�unable to run file

line 3 of file /test/temp/arcexe80/gpserver/amls/request9.aml

AML MESSAGE�stopping execution of AML file due to
ERROR condition

The request9.aml in $ARCHOME/gpserver/amls on the UNIX
server looks like this:

&codepage ANSI

Precision Single Highest

 &RUN \\tashi\hippo1\james\sample.aml

Cause:

1. The Geoprocessing Server was unable to find the AML as the
drive /hippo1 was not mounted on the server.

2. The share name set in the NFS software is HIPPODRIVE, but
the mount point of the drive on the UNIXserver is /hippo.

For example, Windows NT sees \\HIPPO\HIPPODRIVE rather
than \\hippo\hippo1.

Solution:

1. Mount the disk with the AML on it to the UNIX server.

2. Ensure the Windows NT share name and the UNIX disk name
are the same.

When running a job on a UNIX server, the job
completes but the results of the job state an AML
error because the input data does not exist.

Here are the job results:

SET SCHEMAWRITE lock on \\tashi\ashley\data\streams

Coverage \\tashi\ashley\data\streams does not exist

AML MESSAGE�stopping execution of AML due to
ERROR condition

The AML request ($ARCHOME/gpserver/amls/request2.aml)
appears as follows:

&codepage ANSI

LOCKMANAGER \\tashi\ashley\data\streams SET
SCHEMAWRITE

Precision single highest

Build \\tashi\ashley\data\streams lines

LOCKMANAGER \\tashi\ashley\data\streams

Cause:

UNIX cannot resolve the pathname. UNIX is looking for the data
at the location of /ashley/data/streams. In reality, the data is
located at /regina/ashley/data/streams. The problem is that when
the UNIX box  was mapped from Windows NT, it was mapped to
\\tashi\ashley. The share name ashley was set by the UNIX system
administrator through an NFS package�in this case it was
SAMBA.
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Solution:

Make sure that the share name is the same as the disk on UNIX.
The UNIX administrator needs to make sure that the share name
is the same as the UNIX disk name. In this example, the problem
is resolved by mapping \\tashi\regina on Windows NT.

Unable to start the Geoprocessing Server, error
1067

The following error is given when gpmon is used to start the
server:

Error 1067:  The process terminated unexpectedly

C:\arcexe80\gpserver> gpmon -o start -p gps -i esri_gpsvr

esri_gpsvr service failed during initialization.

Please check event log or error log files.

Error starting esri_gpsvr service(997)

Could not start Geoprocessing Server - Check Network and
$ARCHOME disk.

Cause:

The appropriate files or directories were not created in the
%ARCHOME%\gpserver directory.

The gpserver directory should contain the following files:

rqmgr.defs, services.rqm

Solution:

Reinstall ArcInfo Workstation to ensure the required files for the
Geoprocessing Server exist.

Unable to start the Geoprocessing Server, error
2140. An internal Windows NT error occurred.

Solution:

1. Make sure the following directories exist:

 %ARCHOME%\gpserver\tmp_results

%ARCHOME%\gpserver\amls exist.

2. Make sure all users sending jobs to the server have full access
to the tmp_results and amls directories.

3. If you still have this problem, make a note of the contents of
the %ARCHOME%\gpserver\rqmgr.err file and contact ESRI
Technical Support.
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ArcToolbox tree
Displays ArcToolbox toolsets and tools grouped by functionality.

batch mode operation
Executes a given tool two or more times. Includes a utility to save the batch entries as a
geoprocessing ARC Macro Language (AML) script and reload the AML for later execution.

batch table
Displays the input name, user-selected parameters, and output name, where applicable, for all batch
entries.

CAD
See computer-aided design.

computer-aided design
An automated system for the design, drafting, and display of graphically oriented information.

coverage
1. A digital version of a map forming the basic unit of vector data storage in ArcInfo. A coverage
stores geographic features as primary features (such as arcs, nodes, polygons, and label points)
and secondary features (such as tics, map extent, links, and annotation). Associated feature
attribute tables describe and store attributes of the geographic features.

2. A set of thematically associated data considered as a unit. A coverage usually represents a single
theme such as soils, streams, roads, or land use.

custom tool
A tool created by a user and added to the ArcToolbox My Tools toolset.

custom toolset
A folder created by a user within the ArcToolbox My Tools toolset to hold custom tools or group
frequently used ArcToolbox tools.

Glossary
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database management system
A set of computer programs for organizing the information in a
database. A DBMS supports the structuring of the database in a
standard format and provides tools for data input, verification,
storage, retrieval, query, and manipulation.

dataset
A named collection of logically related data items arranged in a
prescribed manner.

DBMS
See database management system.

DLL
See dynamic link library.

dynamic link library
Modules that contain functions and data. A DLL is loaded at
runtime by its calling modules (EXE or DLL).

EXE
See executable.

executable
A program file created from one or more source code files
translated into machine code and linked together.

exit state
The condition of a tool upon closure. If a tool fails due to a
programming bug or command failure, the exit state will be
�failed�.

feature class
1. A classification describing the format of geographic features
and supporting data in a coverage. Coverage feature classes for
representing geographic features include point, arc, node, route-
system, route, section, polygon, and region. One or more
coverage features are used to model geographic features; for
example, arcs and nodes can be used to model linear features
such as street centerlines. The tic, annotation, link, and boundary
feature classes provide supporting data for coverage data
management and viewing.

2. The conceptual representation of a geographic feature. When
referring to geographic features, feature classes include point,
line, area, and surface.

geoprocessing
GIS operations such as geographic feature overlay, coverage
selection and analysis, topology processing, and data
conversion.

Geoprocessing Server
A UNIX- or Windows NT-operating computer that processes
geoprocessing tasks remotely. It includes a utility to schedule
remote processing.

grid
A geographic data model representing information as an array of
equally sized square cells arranged in rows and columns. Each
grid cell is referenced by its geographic x,y location.

Help node
A branch in the ArcToolbox tree, providing overview Help for
ArcToolbox toolsets.
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job
A task scheduled on a Geoprocessing Server for immediate or
later remote processing. A job can be a single tool or batch mode
execution.

layer
A collection of similar geographic features�such as streams,
lakes, highways, political boundaries, or wildlife habitats�in a
particular geographic area for display on a map. A layer doesn�t
store geographic data itself, but instead references the data
stored in a data source such as a coverage or shapefile. You can
create and manage layers as you would any other type of data in
your database.

relate manager
A utility used to build, modify, save, and delete connections
(relates) between tables. Saved connections can be reactivated in
future ArcToolbox sessions.

relational join
The operation of relating and physically merging two attribute
tables using their common item.

tool
An entity in ArcToolbox that performs a specific geoprocessing
task such as generalizing lines. A tool can belong to one or more
toolsets.

toolset
A grouping of tools that perform a similar geoprocessing task.
Custom toolsets can be created within the My Tools toolset to
hold custom tools as well as to group frequently used
ArcToolbox tools.

wizard
A tool that leads a user step by step through an unusually long,
difficult, or complex task.

09Glossary.p65 11/29/2000, 3:55 PM101



09Glossary.p65 11/29/2000, 3:55 PM102



103

12Index A

Accuracy 38
ActiveX 63
Add tools 58
Analysis Tools 29
Append Wizard 14
Arc automation server 61
ARC Macro Language (AML) 30

AML scripts 49
creating 46
editing 46

ArcCatalog 3
dragging and dropping from 44. See also

ArcCatalog
Launch ArcToolbox button 43
minibrowser and name objects 68
Preview tab 16
Standard toolbar 43
standard toolbar 9
thumbnail images 9. See also ArcCatalog
using name objects 68

arcrqmgr executable 89
ArcToolbox tree

customizing 55
defined 99
described 55

Attribute table values 23

B

Batch job 45
Batch mode 44, 45

defined 99
Save AML script 46

Batch table 44
adding a row 45
defined 99
deleting rows 47
editing 46
Save To Script 47

Buffer Wizard 18

C

C++ 61
Client desktop 49
COM interface

IToolBoxTool 62
Connection 9

disk 9
folder 9

Context menu 10
Conversion Tools 29
Coordinate precision 38

creation rule 38
processing rule 38
setting 39

Coordinate resolution 39
Coverage

defined 99
described 1

Custom tools
adding 69
defined 99
described 61
enabling drag and drop 67
requirements 62
Sample VB code 73
VB class 63
VB form 62, 63

Custom toolset 58
adding 59
defined 99
renaming 58
Sample VB code 55

D

Data Management Tools 29
Database management system (DBMS)

defined 100
described 40

Dataset
defined 100
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Delphi 61
DLL 61, 62
Double-precision 38

conditions for using 39
Drag and drop 44

enabling 67
Dynamic link library (DLL)

defined 100
described 61
installing as custom tool 69

E

ESRI ArcToolbox Interfaces 63
Esri_gpsvr instance 88
ESRIUtil automation server 63
EXE 61
Executable (EXE)

defined 100
installing as custom tool 70

Extract Wizard 41

F

Feature attribute tables 40
Feature class

defined 100
described 14
topology 14

Find
using a keyword 32
using a name 32
using an ArcInfo command 32

Find tool 32

G

Geographic information system (GIS) 1
Geoprocessing

defined 100
described 1

Geoprocessing Server 8, 49
adding an instance 94
altering NIS services file 89
arcrqmgr executable 89
creating a connection 50
defined 100
editing connection properties 51
enabling a client 90
getting a job ID 52
Jobs tab 52
managing processes 91
pausing 93
request server error log 95
resuming 93
rqmgr.defs file 91
running AML scripts 49
scheduling a remote process 53
services.rqm 94
services.rqm file 88
setting a port number 94
setting server defaults 91
Settings tab 50
shutting down 93
starting 88
starting a service 88
stopping a service 93
testing connection 51
using a shared directory 90

Geoprocessing Server instance 49, 87
gpmon 93
Gpmon utility 89, 92
Gpservice 88
Grid

defined 100
Grid to Polygon Coverage tool 20

H

Help 34
concepts 35
Find 35

Help (continued)
Help file 34
Help node 34
Help topic 34
Index 35
What�s This? button 34

Help node. See also Help
defined 100
described 57
turning off 57

I

Input and output 12. See also Sticky paths
sticky paths 12

J

Job
defined 101
described 3
multiple jobs 45
scheduling 53

K

Killp utility 95

L

Layer
defined 101
described 9

M

Main toolsets 3, 29
My Tools 3

adding a custom toolset 59
sending tools to 58
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N

Name object 68

O

Open Development Environment
(ODE) 4, 63

Options
Precision tab 38

Overlay Wizard 22

P

Placing tools on top 60
Port number 94
PowerBuilder 61
Precision environment 38
Precision tab 38
Processing environment 50
Projections 12

Q

Query Builder 16

R

Relate environment 40
Relate manager

defined 101
described 40

Related files 40
Relates 40

opening 42
saving 42

Remote Processing. See also Geoprocessing
Server

Remote processing
defining a server connection 50
getting a job's status 52
Jobs tab 52
Settings tab 50

Rqmgr.defs file 91

S

Select tool 16
Send to 58
Services file 94
Services.rqm file 88, 94
Shared directory 90
Significant digits 38
Single-precision 38
Standard toolbar 9
Starting ArcToolbox 28

from the start button 28
from the start menu 11
from Windows taskbar 28
programs menu 28

State Plane 38
Statistics tool 24
Statistics Wizard 25
Sticky paths 12

T

TCP/IP 89
Technical support 4
Thumbnail button 9
Thumbnail images 9
Tool 11, 63

creating a custom tool. See also Tool
defined 101
described 29
finding a tool 32
parameters 45
size and position 29
starting

Tool (continued)
starting (continued)

from ArcToolbox tree 31
from tool menu 31
from tool's context menu 31

Toolset 3
defined 101
described 29
turning off 56

Tutorial 8

U

UTM 38

V

Visual Basic (VB) 4, 61
Sample VB code 73
VB class 63
VB form 63

W

Windows Explorer 67
Wizard

defined 101
described 11
Save to AML 48
summary panel 48

www.esri.com 5
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